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FCC Statement Warning: This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and
used in accordance with the instruction manual, may
cause interference to radio communications. It has been
tested and found to comply with limits for a Class “A”
computing device pursuant to Subpart B of Part 15 of 
the FCC Rules, which are designed to provide reasonable
protection against such interference when operated in a
commercial environment. Operation of this equipment in
a residential area is likely to cause interference in which
case the user, at his own expense, will be required to
take whatever measures may be necessary to correct the
interference.

Canadian Notice This digital apparatus does not exceed the Class A limits
for radio noise emissions from digital apparatus set out
in the Radio Interference Regulations of the Canadian
Department of Communications.

Le présent appareil numérique n’émet pas de bruits
radioélectriques dépassant les limites applicables aux
appareils numériques de la classe A prescrites dans le
Règlement sur le brouillage radioélectrique edicté par le
ministère des Communications du Canada.

European Notice Warning: This is a Class A product. In a domestic 
environment this product may cause radio interference
in which case the user may be required to take adequate
measures. The “CE” mark certifies that this product 
satisfies the requirements of the EU (European Union)
regarding safety, public health, environment and 
consumer protection. (“CE” is the abbreviation of 
Conformité Européenne.) This product is in conformity
with the following directives: 73/23/EEC, low voltage
directive; 89/33/EEC, EMC directive; 93/68/EEC, 
“CE” marking directive.

© Copyright 1996 Polaroid Corporation. All rights reserved.
Specifications are subject to change without notice.



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
om

1 Introduction

What’s in the box? 3

Quick start 5

The remote control and the control panel 12

2 Detailed setup

Setting up your projector 15

Getting started 16

Connecting the projector to your computer 22

Connecting video and audio to the projector 33

Important precautions 38

Adjusting the image 42

Table of contents



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
omii Table of contents

3 Using the projector

Using your projector 45

Using the remote control and the control panel 46

Switching input sources 49

Using the menus 50

Adjusting the image 51

Adjusting the audio 53

Adjusting the remote-control mouse tracking 54

Presentation features 55

Advanced features 59

Menus and keys 61

4 Polaroid F/X

Installing Polaroid F/X 73

Using Polaroid F/X 75

5 Maintenance

Cleaning the lens and mirror 87

Cleaning the projection window 88

Replacing the lamp 89

Cleaning/changing air filters 92

Replacing the batteries in the remote control 96

Temperature extremes 96



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
omTable of contents iii

6 Troubleshooting

Troubleshooting guide 97

Polaview Model 305 Projector parameter adjustments 100

Adjusting your display 102

Unknown/Unrecognized video source 106

Compatibility list 108

Where to get help 112

Polaroid Service Centers 113

Warranty 115

Appendix A: Specifications 117

Appendix B: Parts 119

Appendix C: Sense lines 121

Index 125



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
om

The Polaroid Polaview projector family consists of portable,
color data and video LCD desktop projectors that make shar-
ing data and presenting information as easy as connecting
your computer to your monitor.

The Polaview Model 305 Projector is a high-resolution multi-
media LCD projector that offers the highest, brightest image
quality available. It is compatible with a wide range of com-
puters; from 640 x 480 personal computers to 1280 x 1024
workstations.

The Polaview 
Model 305
Projector in use

1 Introduction

Projected Image

File   Edit   View
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Cyclops interactive pointer system
The Polaview Model 305 Projector comes Cyclops-ready.
The Cyclops interactive pointer system functions like a cord-
less mouse, and allows you control your computer and soft-
ware by pointing at the projection screen.

Introducing the Adobe Acrobat Player System 
The Adobe Acrobat Player Image Display System brings the
functionality of computers and projectors closer together by
eliminating the need to hook a computer up to the projector.
Print your presentation from whatever application you are
using to a special file called a PDF file, and copy or store the
file on a disk. Then place the disk in the Adobe Acrobat Play-
er System disk drive, and start the presentation.

If you would like to order the Adobe Acrobat Player System,
contact your local dealer or refer to Appendix B: Parts for
ordering information.

2 Introduction
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What’s in the box?

After you open the box and remove the projector and the
shrink-wrapped accessory packs, make sure you have all of
the items shown below.

Items included 
with the Polaview
Model 305 
Projector

a Polaview Model 305 h Composite video/audio
Projector cable

b Remote control i 13C3-to-LCD cable

c Polaroid F/X disks j Macintosh-to-LCD cable

d Power cord (U.S.) k VGA-to-LCD cable

e Mini-jack-to-RCA cable

f Computer audio cable

g S-video cable 

Introduction 3
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Also included but • Macintosh-to-LCD adapter
not shown

• SGI-to-LCD cable and adapter

• DEC 3C3-to-LCD cable and adapter

• Macintosh and PC serial cables 
(included with remote)

• 2 AAA alkaline batteries

• User’s Guide

• Product registration card

• European, U.K., and Italian power cords

4 Introduction
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Quick start

To connect the projector to your computer, read the section
appropriate for your hardware in the following Quick start
section (or read Chapter 2, Detailed setup, which lists these
steps in greater detail).

Take a moment to identify the parts of the projector.

The Polaview 
Model 305 
Projector

a Flip mirror f Projection arm

b Flip-mirror-release lever g Projection window

c Projection lens h Power switch

d Arm-release lever i Connector panel

e Control panel

Introduction 5
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Setting up 1 Place the projector on a solid, flat surface.
the projector

2 Position the projector so that the side with the handle is fac-
ing the projection screen.

3 Locate the arm release lever. Slide it gently in the direction
of the arrow (see the illustration below). 

Sliding the lever 
to release the arm

4 The arm pops up. Gently lift the arm until it is fully extend-
ed. Do not force the arm farther.

5 Locate the flip-mirror-release lever on the top of the arm.
Slide it in the direction of the arrow (in the illustration) as
you pull up on the lift tab. This releases the mirror.

Sliding the lever to
release the flip mirror

6 Introduction
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6 Gently tilt the flip mirror approximately 45˚. (You can adjust
the angle later to raise or lower the projected image.)

Tilting the flip mirror 
to a 45 degree angle

Caution: Never push on or force the mirror. Always use
care when opening the mirror assembly. Avoid touching the
surface of the mirror with your fingers.

Connecting the Follow the instructions specific to your hardware.
computer

Connecting PCs

1 Disconnect your computer-to-monitor cable at the computer
end.

2 Connect the free end of the monitor cable to the VGA OUT
connector on the projector.

3 Use the Polaview VGA-to-LCD connector cable (part number
C800-6) to link the projector to the computer. Connect the
end of the cable marked LCD to the projector COMPUTER IN
connector, and the end marked COMPUTER to the comput-
er video-output connector.

Proceed to the section Connecting video and audio.

Introduction 7
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Macintosh computers
Connecting a Macintosh monitor requires the Polaview VGA
/MAC (part number C804) adapter and the existing monitor
cable. Use the Polaview adapter only.

1 Disconnect your computer-to-monitor cable at the computer
end.

2 Connect the free end of the monitor cable to the Polaview
VGA/MAC adapter.

3 Connect the free end of the Mac-to-LCD adapter to the pro-
jector VGA OUT connector.

4 Use the Polaview Mac-to-LCD connector cable (part number
C802-6) to link the projector to the computer. Connect the
end marked LCD to the projector COMPUTER IN connector,
and the end marked COMPUTER to the computer video-out-
put connector.

Proceed to the section Connecting video and audio.

Notebook computers
1 Connect the end of the video cable marked COMPUTER to

the external monitor connector on your notebook comput-
er(or to the video cable adapter supplied with your note-
book computer).

2 Connect the end of the video cable marked LCD to the
FROM COMPUTER connector on the projector.

Proceed to the section Connecting video and audio.

Silicon Graphics workstations
1 Disconnect your computer-to-monitor cable at the computer

end.

2 Connect the free end of the monitor cable to the SGI to LCD
adapter

3 Connect the free end of the SGI-to-LCD adapter to the pro-
jector COMPUTER OUT connector.

8 Introduction
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4 Use the SGI 13C3-to-LCD connector cable (part number
C943-6) to link the projector to the computer. Connect the
end marked LCD to the projector COMPUTER IN connector,
and the end marked COMPUTER to the SGI workstation
video-output connector.

Proceed to the section Connecting video and audio.

Workstations with 13C3 connectors (except SGI)
1 Disconnect your computer-to-monitor cable at the computer

end.

2 Connect the free end of the monitor cable to the projector
COMPUTER OUT connector.

3 Use the 13C3-to-LCD connector cable (part number C801-6)
to link the projector to the computer. Connect the end
marked LCD to the projector COMPUTER IN connector, and
the end marked COMPUTER to the computer video-output
connector.

Proceed to the section Connecting video and audio.

Workstations with BNC connectors
1 Note which BNC connectors you are currently using with

the monitor. (You always use the R, G, and B connectors,
but the way you use the H and V connectors depends on the
computer configuration.) Disconnect your computer-to-
monitor cable at the monitor (BNC) end.

2 Connect the free BNC end to the optional BNC block-to-LCD
connector cable (part number C942-2), connecting the same
BNC connectors used on the monitor. Plug the LCD end of
the cable into the projector COMPUTER IN connector.

3 Connect the optional BNC-to-LCD connector cable (part
number C803-6) to the projector COMPUTER OUT connec-
tor and the monitor BNC-video input. Use the same BNC
connections used with the monitor.

Proceed to the section Connecting video and audio.

Introduction 9
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DEC workstations
1 Disconnect your computer-to-monitor cable at the  comput-

er end.

2 Connect the free end of the monitor cable to the DEC 3C3-to-
LCD adapter (part number C946).

3 Connect the free end of the DEC 3C3-to-LCD adapter to the
projector COMPUTER OUT connector.

4 Use the DEC 3C3-to-LCD connector cable (part number
C946-6) to link the projector to the computer. Connect the
end marked LCD to the projector COMPUTER IN connector,
and the end marked COMPUTER to the workstation video-
output connector.

Proceed to the next section, Connecting video and audio.

Connecting Connect audio and video sources to the projector, using this
video and audio table as a guide. If you need more information, see the

appropriate section in Chapter 2, Detailed setup.

To set this up: Connect this cable: From here: To here:

Video from Composite  VIDEO 1, 2 RCA port on
VCR/ laserdisc audio/video ports on VCR marked 

cable (C497-6) projector VIDEO OUT
or some-
thing similar

Video from S-video cable S-VIDEO 1, 2 VIDEO OUT
S-video (C466-6) ports on  port on 
device projector S-video

device

Audio from Composite  AUDIO IN 1, 2 AUDIO OUT 
VCR/laserdisc audio/video ports on projector port on VCR 

cable (red = right, (red = right, 
(C497-6) white = left) white = left)

Audio from Computer  Left/right AUDIO OUT
computer audio COMPUTER port of the

cable AUDIO IN ports  Mac or the
(C498-6) on projector sound card

of a PC

10 Introduction
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To set this up: Connect this cable: From here: To here:

External Mini-jack-to-RCA cable AUDIO OUT 1, 2 Mini-jack
speakers adapter (C5105) and ports on cable included

mini-jack cable (included projector with speakers.
with speakers)

Stereo system RCA stereo cable AUDIO OUT Left/right
(comes with port on AUDIO IN
stereo) projector ports on 

amplifier

Microphone Microphone cable MIC port on Amplified
supplied with projector microphone
microphone

Turning on Once you connect the computer and any video or audio 
the projector sources, turn on the power:

1 Plug the power cord into the projector power receptacle.
Plug the other end into a properly-grounded wall outlet or
surge protector.

2 Move the switch power on the rear of the projector to the
“on” position. 

3 Press the lamp on/off key to ignite the lamp. The lamp
lights slowly. 

4 To raise or lower the image, tilt the mirror assembly accord-
ingly.

5 Rotate the ring at the base of the projector lens to focus the
image.

Introduction 11
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The remote control and the control panel

The remote control 
and the control panel

Key Function

a MUTE (remote Mutes the audio, or returns the sound.
control only)

b VOLUME +/- Adjusts the audio level.

c On the remote, press this key once to
(Lamp on/off) clear a black screen. The lamp stays on.

On both the remote control and the 
control panel, turns the lamp off if you
hold it down for more than 2 seconds. 
On the control panel, the green indicator 
light above this key illuminates when the 
lamp is on.

d SOURCE Cycles through the various input 
sources, including video, computer,
the Adobe Acrobat Player System mode.

e PROG 1 (remote Executes the function you define in the
control only) Preferences menu.

VOLUME

MUTE

MENU

SETUPSOURCE

PROG   2PROG   1

— +

SOURCESCALE CLEAR

SETUP

MENUd
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Key Function

f MouseDisk Emulates a left-button mouse click when
(remote control you press the center of the disk.
only)

Acts like an arrow key when you press
the edges of the disk.

Toggles between Draw and Move 
modes in the Draw tool, and controls 
the mouse pointer.

In Adobe Acrobat Player System menus,
controls the mouse pointer.

g MENU Turns the menus on and off.

h SETUP Adjusts the sync, contrast, brightness, 
tint, and image position settings.

i SCALE/PROG 2 In computer or video mode, the SCALE 
key enlarges or compresses the image 
to fit the image to fit the 1024 x 768 
resolution of the projector. To return the 
image to its original size, press this key 
again.

For the Adobe Acrobat Player System 
mode, this key selects the current object.

Set the function of the PROG 2 key 
(remote control only) in the Preferences 
menu.

j Reverse/ In an Adobe Acrobat Player System 
Forward/ presentation, Reverse/Forward moves to 
Pause the next/previous slide.
(remote control 

Pause suspends the current slide in an 
only)

Adobe Acrobat Player System 
presentation.

Pause opens See-it/Show it in 
Polaroid F/X.

Introduction 13
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Key Function

k Over-temp Illuminates if the projector is too hot, 
indicator or if the fans malfunction, indicating 
(control panel that the lamp was automatically turned 
only) off. For over-temp conditions, see 

Chapter 6, Troubleshooting for more 
information.

l Replace lamp Flashes for 90 seconds after you turn 
(control panel off the lamp.
only)

Illuminates when the recommended
lamp life is exhausted.

m Arrow keys Move right/left among menus; move
(control panel up/down on menu items.
only)

In Adobe Acrobat Player System 
presentations, right/left moves to 
the next/previous slide.

In Adobe Acrobat Player System menus, 
these keys navigate the menus.

Pan and position the computer image.

n CLEAR Clears the display to white, for use with
(control panel overhead transparencies.
only)

Clears the screen to black if you press 
CLEAR for two seconds.

14 Introduction
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Setting up your projector

Before you begin, take a moment to identify the parts of the
projector.

The Polaview
Model 305 
Projector

a Flip mirror f Projection arm

b Flip-mirror-release lever g Projection window

c Projection lens h Power switch

d Arm-release lever i Connector panel

e Control panel

2 Detailed setup
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Getting started

Opening the projector To open the projector:

1 Place the projector on a solid, flat surface.

2 Position the projector so that the side with the handle is fac-
ing the projection screen. The connector panel faces away
from the projection screen, as illustrated below.

Positioning the
projector in front 
of the projection
screen

3 The projector must be parallel to the floor. If you use a
media cart, make sure the wheels are locked to prevent it
from moving.

16 Detailed setup
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Top and  side views 
of the projector

4 Locate the arm release lever beside the control panel, on the
top of the projector. Slide it gently in the direction of the
arrow. 

Sliding the lever to
release the arm

Detailed setup 17
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5 The arm pops up. Gently lift the arm until it is fully extend-
ed. Do not force the arm farther.

The arm pops up 

6 Locate the flip-mirror-release lever on the top of the arm.
Slide it in the direction of the arrow while pulling up on the
lift tab. This releases the mirror.

The flip-mirror-
release lever

18 Detailed setup
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7 Gently tilt the flip mirror open approximately 45˚ (you can
adjust the angle of the mirror later, to raise or lower the pro-
jected image).

Opening the 
flip mirror

Caution: Never push on or force the mirror. Always use
care when opening the mirror assembly. Avoid touching the
surface of the mirror with your fingers.

Closing the projector To close the projector, reverse the opening procedures.

1 Tilt the mirror down into the arm until it latches.

2 Gently swing the arm down until it clicks into place. The
latch should click when the arm is completely retracted.

Detailed setup 19
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Moving the projector You should be sure to close the projector securely and dis-
connect all cables before moving it. The projector has a
recessed carrying handle on its side. To gain access to the
handle, just push one side of it in; the other side automati-
cally releases (as illustrated below).

Gaining access to
the recessed handle

If you must move the projector while it is open, grasp it
securely at the sides, by the lower part of the housing, to
support the weight of the projector.

Moving the projector
while it is open

20 Detailed setup
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Turning on The projector and the external monitor (should you use one)
the projector should be turned on before you turn on your computer. This

ensures that the computer properly senses the display dur-
ing the start-up process.

On the rear panel of the projector there is a power-cord
receptacle and a power switch.

The power switch

To turn on 1 Plug the power cord into the power-cord receptacle.
the projector

2 Plug the other end of the power cord into a properly 
grounded electrical outlet.

3 Move the power switch to the “on” position.

4 Press the key to turn on the lamp. The lamp ignites slowly.

5 If you have not already done so, connect the projector to
your computer and external monitor (if you use one).

6 Turn on your computer and external monitor (if you use one).
You should see a projected image of your computer screen.

Note: The projector consumes 800 watts of power. Most
circuits surge protectors support 1,200 watts. Be sure to
connect any peripheral equipment to a separate circuit or
surge protector.

Detailed setup 21
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Connecting the projector to your computer

Take a moment to review the projector connector panel.

The connector 
panel of the 
projector

Port Connects to Cable

AUDIO 1 IN Left and right ports connect Composite
AUDIO 2 IN to a video source, bring audio/video.

audio into the projector. cable.

VIDEO 1 Connects the projector to a  Composite  
VIDEO 2 video camera, laserdisc audio/video 

player, television, or a VCR cable.
(NTSC/ PAL/SECAM source) 
to bring video from these 
sources into the projector.

S-VIDEO 1 Connects the projector to S-video 
S-VIDEO 2 an S-video source to bring cable.

video into the projector.

COMPUTER Left and right ports connect  Computer 
AUDIO IN to the computer; bring  audio cable.

audio into the projector.

22 Detailed setup
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Port Connects to Cable

AUDIO OUT Connects to external Audio cable.
speakers or an external 
sound system to send 
stereo audio out.

CYCLOPS* Connects to the computer RS-232 cable,  
to use the Polaroid F/X (PC, Mac, or
software or the optional Workstation).
Cyclops interactive 
pointer system.

MIC Connects an external External
microphone to the microphone
projector. cable.

COMPUTER Connects to the computer PC, Mac, 
IN to bring computer video Sun, SGI, or

into the projector. DEC.

COMPUTER Connects a workstation Existing 
OUT monitor to the projector monitor 

for simultaneous display. cable.**

VGA OUT Connects a PC or Macintosh Existing 
monitor to the projector for monitor
simultaneous display. cable.**

* Instructions for connecting to this port are also included in the Cyclops
User’s Guide.

** You may also need to use an adapter.

To connect the projector to virtually any PC, Macintosh, or
workstation, choose the  Polaview cable(s) that matches
your existing computer-to-monitor connection.

You normally need only one Polaview cable. Use this cable
to connect the projector to your computer video-output con-
nector. Use the existing computer-to-monitor cable if you
also want to connect your monitor.

Detailed setup 23
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Note: You do not need to shut off power to either the com-
puter or projector when you connect the two units to one
another. Available cables include:

• 13C3-to-LCD connector cable (part number C801-6)

• VGA-to-LCD connector cable (part number C800-6)

• Mac-to-LCD connector cable (part number C802-6)

• Mac-to-LCD adapter (part number C804-0)

• SGI 13C3-to-LCD connector cable (part number C943-6)

• SGI-to-LCD adapter (part number C947-12)

• DEC 3C3-to-LCD connector cable (part number C948-6)

• DEC 3C3-to-LCD adapter (part number C947-10)

• Optional BNC block-to-LCD connector cable (part number
C942-2)

• Optional BNC-to-LCD connector cable (part number C803-6)

Computer video always connects to the COMPUTER IN con-
nector (13C3) on the projector.

The COMPUTER IN
connector

You can display data on a separate monitor in addition to
the projector. COMPUTER OUT connections can be made
with the projector and computer power on.

The video output 
connectors

24 Detailed setup
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Projecting without an attached monitor
Some display cards rely on sense-line information from the
monitor to configure themselves for the correct display res-
olution. The absence of sense-line information causes some
display cards to output a default video signal and actually
prevents some video cards from outputting video at all.

If you connect the projector to a computer without a moni-
tor, turn on your system and check to see if the display reso-
lution is acceptable. If it is not, you need to set the sense
lines to make the projector emulate a monitor (see Appen-
dix C: Sense lines).

PCs 1 Disconnect your computer-to-monitor cable at the computer
end.

2 Connect the free end of the monitor cable to the VGA OUT
connector on the projector.

3 Use the Polaview VGA-to-LCD connector cable (part number
C800-6) to link the projector to the computer. Connect the
end of the cable marked LCD to the projector COMPUTER IN
connector, and the end marked COMPUTER to the comput-
er video output connector.

PC video-out 
connection 
to the projector
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Macintosh computers Connecting a Macintosh monitor requires the Polaview
VGA/MAC adapter (part number C804) and the existing
monitor cable. Use the Polaview adapter only.

1 Disconnect your computer-to-monitor cable at the computer
end.

2 Connect the free end of the monitor cable to the Polaview
VGA/MAC adapter.

The Macintosh-
to-LCD connection

3 Connect the free end of the Mac-to-LCD adapter to the pro-
jector VGA OUT connector.

Note:  Macintosh users that do not connect an external
monitor may need to set Model 305 sense lines to achieve
the desired display resolution. See Appendix C: Sense lines
for more information.

4 Use the Polaview MAC to LCD connector cable (part number
C802-6) to link the projector to the computer. Connect the
end marked LCD to the projector COMPUTER IN connector,
and the end marked COMPUTER to the computer video out-
put connector.

26 Detailed setup
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The Polaview 
Macintosh-to-LCD
adapter

Notebook Use the appropriate Polaview video cable to connect your 
computers notebook computer to the projector.

1 Connect the end of the Polaview video cable marked COM-
PUTER to the external monitor connector on your notebook
computer (or to the video cable adapter supplied with your
notebook computer).

2 Connect the end of the Polaview video cable marked LCD to
the COMPUTER IN connector on the projector.

Notebook 
computer 
connections

Detailed setup 27
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Note: Some notebook computers require that you press a
combination of keys or use a control panel to set the projec-
tor as an external monitor. Refer to your notebook computer
manual for more information.

Workstations 13C3 video connections 
(except Silicon Graphics workstations)
If your workstation has a 13C3 connector at the computer
video port:

1 Disconnect your computer-to-monitor cable at the computer
end.

2 Connect the free end of the monitor cable to the projector
COMPUTER OUT connector.

3 Use the Polaview 13C3-to-LCD connector cable (part num-
ber C801-6) to link the projector to the computer. Connect
the end marked LCD to the projector COMPUTER IN connec-
tor, and the end marked COMPUTER to the computer video-
output connector.

Workstation 
video-out connection 
to the projector
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Silicon Graphics 13C3 video connections
If you have a Silicon Graphics workstation with 13C3 con-
nectors at the computer and monitor video ports:

1 Disconnect your computer-to-monitor cable at the computer
end. 

2 Connect the free end of the monitor cable to the Polaview 
SGI-to-LCD adapter.

3 Connect the free end of the SGI-to-LCD adapter to the pro-
jector COMPUTER OUT connector.

Note:  SGI workstation users that do not connect an exter-
nal monitor need to set Model 305 sense lines to achieve
the desired display resolution. Refer to Appendix C: Sense
Lines for more information.

4 Use the Polaview SGI 13C3-to-LCD connector cable (part
number C943-6) to link the projector to the computer. Con-
nect the end marked LCD to the projector COMPUTER IN
connector, and the end marked COMPUTER to the SGI
workstation video-output connector.

Silicon Graphics 
workstation 
connections
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DEC 3C3 video connections
If you have a DEC workstation with 3C3 connectors at the
computer and monitor video ports:

3C3 connector

1 Disconnect your computer-to-monitor cable at the computer
end.

2 Connect the free end of the monitor cable to the Polaview
DEC 3C3-to-LCD adapter (part number C947-10).

3 Connect the free end of the DEC 3C3-to-LCD adapter to the
projector COMPUTER OUT connector.

4 Use the Polaview DEC 3C3-to-LCD connector cable (part
number C948-6) to link the projector to the computer. Con-
nect the end marked LCD to the projector COMPUTER IN
connector, and the end marked COMPUTER to the worksta-
tion video-output connector.

BNC video connections
If your workstation does not have a 13C3 video-port connec-
tor at the computer video port, but has a BNC connector at
the monitor, you need the optional Polaview BNC cables.

1 Note which BNC connectors you are currently using with
the monitor. (You always use the R, G, and B connectors,
but the way you use the H and V connectors depends on the
computer configuration.) Disconnect your computer-to-
monitor cable at the monitor (BNC) end.
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2 Connect the free BNC end to the optional Polaview BNC
block-to-LCD connector cable (part number C942-2), con-
necting the same BNC connectors used on the monitor.
Plug the LCD end of the cable into the projector COMPUTER
IN connector.

Using the BNC 
block-to-LCD 
connector cable

3 Connect the optional Polaview BNC-to-LCD connector cable 
(part number C803-6) to the projector COMPUTER OUT con-
nector and the monitor BNC video input. Use the same BNC
connections used with the monitor.

BNC-to-LCD 
connector cable 
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Connecting the Cyclops interactive pointer system
The Cyclops interactive pointer system uses a built-in cam-
era to function like a cordless mouse. With the Cyclops sys-
tem, you can control your computer cursor by moving the
hand-held Cyclops wand or optional laser pointer. Instruc-
tions for setting up your Cyclops system are included with
your Cyclops kit.

Connecting the Adobe Acrobat Player System
The Adobe Acrobat Player Image Display System brings the
functionality of computers and projectors closer together by
eliminating the need to hook a computer up to the projector.
Print your presentation from whatever application you are
using to a special file called a PDF file, and copy or store the
file on a disk. Then place the disk in the Adobe Acrobat Play-
er System disk drive, and start the presentation.

To connect the Adobe Acrobat Player System to the projec-
tor, see the installation card that comes with your Adobe
Acrobat Player System package for instructions.
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Connecting video and audio to the projector

This section describes how to connect audio and video to
your projector. The Polaview Model 305 Projector has multi-
ple inputs for audio and video. If you are connecting only
one audio or video source to your projector, use the VIDEO
1 and AUDIO 1 ports. Make sure that you connect your
audio and video to the corresponding group. If you connect
video to group 1 and audio to group 2, you cannot hear the
audio. Even though you connect both COMPUTER AUDIO
IN and AUDIO IN, only one of them is active:

• If you select computer video, COMPUTER AUDIO IN is
active.

• If you select NTSC/PAL/SECAM/S-video, AUDIO 1 IN is
active.

Connecting video The projector can project video from NTSC, PAL or 
from a VCR SECAM sources (i.e., VCRs, laserdisc players and video

cameras).

The projector 
connected to 
a VCR
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The composite audio/video cable (part number C497-6) has
a yellow, red, and white RCA plug at each end. To connect
an NTSC, PAL, or SECAM source to your projector, make
the appropriate cable connections, as indicated in the fol-
lowing chart:

Cable Projector port VCR connector

Yellow VIDEO 1 or 2 VIDEO OUT, 
TO MONITOR, etc.

White AUDIO 1 or 2 IN L AUDIO OUT
(white plug)

Red AUDIO 1 or 2 IN R AUDIO OUT
(red plug)

Connecting video The projector can also project video from an S-video 
from S-video sources source.

1 Connect one end of the S-video cable (part number C466-6)
to the VIDEO OUT connector on the video source. The cable
has identical, round 4-pin connectors on either end.

2 Connect the other end of the cable to the projector 
S-VIDEO 1 port.
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Connecting audio Use the COMPUTER AUDIO IN port to connect audio from a
from the computer computer.

1 Insert the mini jack end of the computer audio cable (part
number C498-6) into the AUDIO OUT connector of a Macin-
tosh or the sound card of a PC.

2 Insert the RCA jacks at the other end of the computer audio
cable into the projector left and right COMPUTER AUDIO IN
ports.

The projector 
COMPUTER
AUDIO IN port

Connecting a To use a microphone while projecting an NTSC, PAL,
microphone SECAM or S-video image, plug an amplified or wireless

microphone equipped with a line level output (maximum 
1 volt, peak-to-peak) into the MIC port.
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Connecting The projector contains an internal stereo system consisting 
external speakers of an amplifier and two speakers. Although this system pro-

vides high-quality stereo output, a multimedia presentation
may require external speakers or an external sound system.

When connecting external speakers, use the optional
Polaview loudspeaker system (part number A55) or a simi-
lar system.

1 Insert the two RCA plugs of on the mini-jack-to-RCA cable
adapter (part number C5105) into the projector AUDIO OUT
ports.

2 Connect the other end of the mini-jack-to-RCA cable adapter
to the speaker cable, included with your speakers

3 Connect speaker A to speaker B using the cables supplied
with the speaker system. 

Connecting external
speakers
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Connecting an To connect the projector to an external stereo system,
external

1 Using the computer video/audio cable (C497-6), insert thestereo system
white and red RCA plugs into the left and right AUDIO OUT
ports of the projector.

2 Insert the white and red RCA plugs at the other end of the
cable into the left and right AUDIO IN ports of the external
amplifier.

External stereo 
system connections

Detailed setup 37
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Important precautions

To avoid any potential hazards to the projector, make sure
not to obstruct the air-intake and exhaust grills. Do not oper-
ate the projector if these areas are clogged or blocked.

Allow sufficient 
air flow

Caution: The lamp chamber gets very hot during opera-
tion, especially the ceramic sockets at each end of the lamp.
Be careful when you open the lamp chamber or change the
lamp. To allow that area to cool down, press the button to
turn off the lamp and let the fan cool the projector for at
least five minutes before you touch any of those compo-
nents. See Chapter 5, Maintenance, for more information.
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Turning the lamp The lamp is off when you first turn on the projector. Press
on and off the key (shaded gray in the illustration below) on the

remote control or control panel to turn the lamp on. The
green power-indicator light illuminates. It takes a few sec-
onds for the lamp to warm up.

The key

To turn the lamp off, press and hold the key for about two
seconds. When you turn the lamp off, the projector fans
continue to run for about two minutes. Allow the fans to run
until they automatically turn off. This lengthens the lamp life
and helps ensure that the projector cools properly. Turning
the lamp off does not turn off the projector. To turn the
power off, move the power switch on the back of the projec-
tor to the “off” position.

After you turn off the lamp, you can immediately turn it back
on within five seconds. If you wait longer than five seconds,
you must then wait 90 seconds before turning it back on.
This is a built-in safety feature that helps prevent damage to
the lamp. Press the key again to turn on the lamp once
more. The lamp illuminates slowly, to prolong lamp life.
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The projector has safeguards built in to protect it from over-
heating. In the rare event that the projector overheats, the
lamp shuts off automatically and the over-temp indicator
(shaded gray in the illustration below) on the control panel
illuminates.

The over-temp
indicator light

In the unlikely event that an over-temperature condition
occurs, see Chapter 6, Troubleshooting, for information on
restarting your projector.
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Adjusting the image

Raising or lowering To raise or lower the projected image, tilt the mirror on top
the image of the arm up, to move the image higher, or down, to move

the image lower.

Focusing the image To focus the image, rotate the ring just below the projection
lens, beneath the mirror, until the image is sharp and clear.

Rotating the 
focus ring

Detailed setup 41
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Correcting keystoning The normal projected image has a rectangular shape. A key-
stoned image has a trapezoidal shape (as illustrated below).

A normal vs. 
a keystoned image

Keystoning occurs when the front of the projector is not per-
pendicular to the projection screen (the vertical plane) or
when the projector is not parallel to the floor (the horizontal
plane). Keystoning can also occur when the projector is tilt-
ed sideways.

To correct keystoning, make sure that the projector is at a
right angle to the projection screen.

To project images high enough for the entire audience to
view, the projector has a built-in 4.5˚ correction for keyston-
ing.

42 Detailed setup
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Image size The size of the projected image depends on the distance
between the projector and the projection screen. The follow-
ing table shows the projected image size, measured diago-
nally, based on this distance.

Distance from screen Diagonal image size

4 ft/1.2 m 46 inches

6 ft/1.8 m 69 inches

8 ft/2.4 m 92 inches

10 ft/3.0 m 115 inches

12 ft/3.6 m 138 inches
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Using your projector

The Polaview Model 305 Projector is designed with ease of
use and simplicity in mind. With the remote control or the
control panel, most of the common functions are right at
your fingertips.

To execute most of the functions you need during your pre-
sentation, such as adjusting or muting the volume and pro-
ceeding from one slide to the next, just press the appropri-
ate button on the remote control or the control panel.

This chapter describes keys on the remote control and con-
trol panel and their functions. It also describes how to use
the various projector and menu settings.

3 Using the projector
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Using the remote control and the control panel

The keys on the 
remote control and 
the control panel

SOURCE key Use the SOURCE key to switch between the various video
input sources you connect, such as the computer video
input, NTSC/PAL/SECAM video input, S-video input, or
Adobe Acrobat Player System input.

SETUP key Use the SETUP key to make your pre-presentation adjust-
ments, such as sync, brightness, contrast, tint, and image
position.

/+VOLUME- Use the VOLUME keys to adjust the volume from the projec-
tor internal speakers and any connected external speakers.

PROG 1 and Use these keys to execute the function you define in the
PROG 2 keys Preferences menu. In the Adobe Acrobat Player System dia-

log boxes, the PROG 2 key selects the highlighted item.

Reverse/Forward/Pause In an Adobe Acrobat Player System presentation, these keys
reverse or advance to the next slide The Pause key sus-
pends the timer for a slide during an Adobe Acrobat Player
System presentation. It also opens See-it/Show-it in
Polaroid FX.
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MouseDisk When you press the center of the MouseDisk, it functions
like a mouse click. When you press the edges of the Mouse
Disk, it functions like an arrow key. 

In the Draw tool, this key toggles between Draw and Move
modes. It also controls the mouse pointer. In Adobe Acrobat
Player System dialog boxes, press the edges of this button
to move the mouse pointer, and the center to select options.

MUTE key Use the MUTE key to turn off the sound from the internal or
external speakers. Press it again to restore the sound.

MENU key Press the MENU key to activate the on-screen menus. Press
it again to exit the menus.

(Lamp on/off) This key turns the lamp on and off. On the remote control,
press and release this key once quickly to display a black
screen. To turn the lamp off, press and hold this key for at
least two seconds. This key does not turn off the projector.

Arrow keys When the projector menus are displayed, the arrow keys on
(control panel only) the control panel move the mouse pointer from menu to

menu (left and right arrow) and to items on the current
menu (up and down arrow).

When the projector menus are not displayed, these keys
pan or position the image in computer or video mode.

When the Adobe Acrobat Player System menus are dis-
played, these keys navigate those menus and dialog boxes.

SCALE/ The SCALE key enables you to fit a projected image on the
(Adobe Acrobat screen while your system displays at a higher resolution.
Player System) Press this key to scale images larger than 1024 x 768 or to

enlarge 640 x 480 images. Press this key a second time to
return to the normal display.

In the Adobe Acrobat Player System mode, this button has
multiple functions. See your Adobe Acrobat Player System
user’s guide for more information.
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CLEAR Press the CLEAR key to clear the screen to a bright white
background. This is useful when you want to show a trans-
parency during your presentation. Press and hold the
CLEAR key for approximately two seconds to clear the
screen to black. To display video once more, press the
CLEAR key again.

(Over-temp This light illuminates if the projector becomes too hot or
indicator light, when one of the fans malfunctions. When this light 
control panel only) illuminates, the lamp automatically shuts off. In the unlikely

event of an over-temperature condition, see Chapter 6,
Troubleshooting, for more information.

(Lamp-indicator This light illuminates when the lamp needs to be replaced.
light, control panel only) It also flash for about 90 seconds after you turn off the

lamp.
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Switching input sources

With some presentations, you have multiple input sources
connected to the projector. Input sources are VCRs, comput-
ers, laserdisc players, the optional Adobe Acrobat Player
System system, or any piece of hardware that produces
images you want to project through your projector. For
example, you may have a VCR, the Adobe Acrobat Player
System, and your computer connected.

To switch from one of source to another, just press the
SOURCE key. Use the SOURCE key to scroll through the
various sources currently connected to your projector.

Using the projector 49
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Using the menus

Before starting your presentation, you want to fine-tune the
image to get the sharpest, clearest image possible. The
handful of settings you use the most are easy to access; just
press the SETUP key and make your adjustments. For the
settings you use less frequently, gain access to the projector
menus to make your adjustments. To open the menus,
press the MENU key once.

Each menu command offers a list of related settings. Each
setting is described in detail later in this chapter. For now, it
is important to know how to choose a menu and adjust the
various settings.

To navigate through the menus, press the edges of the
MouseDisk on the remote control or use the optional
Cyclops wand or laser pointer. (On the projector control
panel, press the up and down arrow keys.) As the cursor
moves up and down the main menu, additional options
appear to the right.

For most settings, you make incremental adjustments by
moving a slide bar. To move a slide bar, press the edges of
the MouseDisk, press the up and down arrow keys on the
projector control panel, or use the optional Cyclops wand or
laser pointer.

Changing the language To change the menus to a different language, choose
on the menus Language on the Preferences menu. Then choose the lan-

guage you prefer. You can select from English, Spanish,
French, German, and Italian. The menus change instantly to
the language you select.

Saving your settings You save your current settings when you exit each menu.
You also save your settings if you hold key for two sec-
onds (to turn off the lamp).

If two or more presenters want to save their settings sepa-
rately, see Advanced features.
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Reverting to the If you want to revert to the original factory settings for a 
factory defaults specific computer source, choose Image, Factory Defaults,

Reset.

To reset the projector itself, press the CLEAR key, then press
each of the four arrow keys on the projector control panel
once. The power LED indicator blinks twice to indicate the
projector has been reset.

Adjusting the image

Press the SETUP key to gain access to most of the settings
you need to adjust the image.

Note: The choices on the Setup menu vary, depending on
your current input source.

Adjusting the To adjust the brightness, press the SETUP key until the 
brightness Brightness slider appears. Press the edges of the

MouseDisk, use the optional Cyclops wand or laser pointer,
or press the left and right arrow keys to move the slider.

You can also adjust the brightness by opening the projector
menus and choosing Bright from the Image menu.

Adjusting the To adjust the contrast, press the SETUP key until the 
contrast Contrast slider appears. Press the edges of the MouseDisk,

use the optional Cyclops wand or laser pointer, or press the
left and right arrow keys to move the slider.

You can also adjust the contrast by opening the projector
menus and choosing Contrast from the Image menu.

Correcting shimmering If your projected image has horizontal streaks, or seems to 
or streaks shimmer slightly, adjust the Sync setting. (This setting is

only active when the source is your computer.)

Press the SETUP key until the Sync slider appears. Press the
edges of the MouseDisk, use the optional Cyclops wand or
laser pointer, or press the left and right arrow keys to move
the slider. Repeat until the streaks disappear.
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You can also adjust the sync by opening the projector
menus and choosing Sync from the Image menu.

Correcting If the projected image has vertical black lines or bands, 
vertical banding adjust the Dot Clock (DotClk..) setting on the Image menu to

eliminate them. (This setting is only available when the
source is your computer.)

Adjusting the color To correct the tint, press the SETUP key and adjust the slide 
tint and saturation bar for the Tint setting (availability depends on your current

input source).

If you prefer, you can also adjust the Red, Green, and Blue
settings on the Image menu (while the computer or Adobe
Acrobat Player System is the input source) or the Tint set-
ting (while video or S-video is the input source).

Adjusting image To move the on-screen image, press the SETUP key and 
position adjust the slide bar for Hor. Pos. (Horizontal Position) or

Vert. Pos. (Vertical Position). You can also find these settings
on the Advanced menu.

Switching to rear To switch to rear projection mode (projecting from behind 
projection mode the projection screen instead of in front of the screen),

choose Projection, Rear from the Projector menu.
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Adjusting the audio

You can adjust the volume from the remote control, the
control panel, or the menus. The Audio menu contains addi-
tional audio controls.

Displaying and hiding You can display a volume indicator while you increase or 
the volume indicator decrease the volume of the internal speakers. To display the

volume indicator, choose Preferences, On-Screen, Display.
To suppress this visual indicator, set On-Screen to Hide.

Adjusting the volume To adjust the volume of the internal speakers and any exter-
nal speakers you connect, press the + or - VOLUME key on
the remote control or control panel. You can also make
adjustments through the Audio menu.

Muting the audio To mute the audio, press the MUTE key on the remote con-
trol, or choose Mute from the Audio menu.

To turn the sound back on, press the MUTE key a second
time or choose Mute, Normal from the Audio menu.

Adjusting bass To adjust the level of bass or treble, choose the 
and treble corresponding command on the Audio menu, then move

the slide bar in the appropriate direction.

Adjusting fade The fade slider allows you to choose between the internal 
and balance speakers in your projector and an external loudspeaker sys-

tem like the Polaview loudspeaker system (part number
A55). The balance slider allows you to control the level of
sound from the left and right sides of your sound system.

To adjust the fade and balance, choose the corresponding
command on the Audio menu, then move the slide bar in
the appropriate direction.

Adjusting the volume To increase or decrease the volume of the microphone, 
of the microphone choose Mic. Volume from the Audio menu, then move the

slide bar in the appropriate direction.

Switching between To switch between stereo and monaural mode, choose 
stereo and monaural Audio mode from the Audio menu, then choose the 
mode appropriate setting.
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Adjusting the remote-control mouse tracking

Use this setting to adjust how fast the pointer moves. To
increase or decrease the remote-control mouse tracking,
choose Mouse Tracking from the Tools menu and move the
slider in the appropriate direction.
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Presentation features

Once you adjust the image and audio settings, you are
ready to start your presentation. This section describes
some of the features of the Polaview Model 305 Projector
that you may want to use during your presentations.

Using the Draw tool The Draw tool is a unique feature that lets you draw or
annotate on the projected image. You can choose from
three styles:

• Overlay lets you highlight or draw on top of the projected
image.

• WhiteBoard clears the screen and provides a bright back-
ground for drawing.

• BlackBoard clears the screen and provides a dark back-
ground for drawing.

To use the Draw tool:

1 Open the menus and choose Tools.

2 From the Tools menu, choose Draw mode, then specify
whether you want the Overlay, WhiteBoard, or BlackBoard.
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3 From the Tools menu, choose Draw, On. The Draw toolbar
appears in the upper left corner of the projected image. It
has four buttons:

The Draw toolbar

Button Function

Click this button to select the 
Draw tool.

Click this button to select the Eraser.
You can erase any of your annotations.

Click the Clear All button to erase all
previous annotations.

Click this button to select a new color.
This button displays the currently
selected color.
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Note: If you use the optional Cyclops interactive pointer
system, you can also click above the image to activate the
Draw tool.

4 Select one of these buttons, then use the Cyclops wand,
laser pointer, or the MouseDisk to draw on the projected
image.

To open the color palette:

1 Click the Color box or the icon in the upper right corner of
the projected image. Eight color-selection boxes appear.

The color-selection
boxes

2 Click the color you want to use, then click the Color box or
icon again to hide the color-selection boxes.

To draw, click and hold the MouseDisk for approximately
two seconds, then release it. Use the edges of the
MouseDisk to draw on the screen. When you are in Draw
mode, the cursor is black. When you are in Move mode, the
cursor is white.

To draw with the optional Cyclops interactive pointer sys-
tem, click and hold the Cyclops wand button while you
move the cursor around the screen. Release the button to
end the drawing.
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You can move the Draw toolbar to another spot on the pro-
jected image. Click and hold the title bar of the toolbar, drag
it to a new location, and release the button. See Program-
ming the remote control later in this chapter, for more infor-
mation.

When you finish using the Draw tool, click the close box in
the upper left corner of the Draw toolbar.

If you use Draw features frequently, consider programming
either the PROG 1 or PROG 2 key, so you can open the Draw
tool quickly with the press of a key.

Setting the timer The Polaview Model 305 Projector includes a break timer, 
(for intermission) for lunch breaks, intermissions, question-and-answer ses-

sions, or any other timed pause. Your audience can see a
countdown displayed of the number of minutes remaining.

To use the timer, first set the length of the break. Choose
Tools, Break Timer Value, then indicate the length of the
break, in minutes. You can set a break for up to one hour.

After you indicate the length of the break, choose Tools,
Break Timer, On to start the timer. To turn the Break Timer
off, press the Menu key on the remote or control panel.

Projecting The CLEAR key clears the projected image, allowing you to
transparencies project transparencies in the middle of your presentation. 

You can clear to either a white or black background. Press
the CLEAR key once quickly to clear to a white background.
Press and hold it for at least two seconds to clear to a black
background. Press CLEAR again once quickly, to return the
projected image.

Note: The panel area on the projector is 6 x 8 in., slightly
smaller than the panel area of most overhead projectors
(typically 8.5 x 11 in.). You must adjust the focus to display
transparencies.
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Using the SCALE key The SCALE key lets you fit larger images on one screen. 
to zoom, reduce, Use this key to compress 1280 x 1024 or 1152 x 900 images 
and pan images to fit the 1024 x 768 screen resolution, or to enlarge a 640 x

480 image to fit the screen. Press the SCALE key a second
time to return the image to its original size.

To pan an image that does not fit on the screen (images
larger than 1024 x 768), press the arrow keys on the projec-
tor control panel.

Note: You can set the top and left pan limits by adjusting
the Advanced, Horiz. Pos. (horizontal), Vert. Pos. (vertical)
settings in the projector menus.

Advanced features

The Polaview Model 305 Projector offers several advanced
features to enhance your presentations. For example, you
can program two keys on the remote control, assigning
them specific functions. You can also save setting profiles,
allowing two presenters that use the same projector to save
customized settings. 

Programming You can program two keys on the remote control, PROG 1 
the remote control and PROG 2, to execute commonly-used functions or to

gain access to a setting that you frequently need to adjust.

To program the PROG 1 and PROG 2 keys, open the projec-
tor menus and choose Preferences. Choose the key you
want to program (PROG 1 or PROG 2) and assign the func-
tion or setting you want to use.

Note: If you want to assign one of the Polaroid F/X effects
to one of the programmable keys, you must select Host in
the Preferences menu.
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Saving a user profile The Polaview Model 305 Projector permits two presenters
to save their settings and recall them each time they give
presentations.

To save current video settings as a profile, open the projec-
tor menus and choose Advanced, User. Then select User A
or User B, and adjust each setting you want to save. By exit-
ing the projector menus, you save your settings as a profile.

Note: You cannot save sense-line and front/rear settings as
part of the profile. Sense-line settings are automatically set
when you turn on the monitor that is connected to the pro-
jector.

When you want to use your profile, open the projector
menus and choose Advanced, User then select your profile
(User A or User B). The settings take effect immediately.
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Menus and keys 

The Main menu

Menu What it contains

Tools Settings for the Draw tool, 
Break Timer, and mouse tracking.

Cyclops Commands for calibrating the Cyclops
interactive pointer system and button 
selection.

Input Source Settings for computer video, S-video
and Adobe Acrobat Player System 
input sources, and a display-only
screen of current VSync, HSync, 
Lines, and Sense measurements.

Image Settings for brightness, sync, tint, 
saturation, contrast, color, dot clock,
and interlace assignment.

Audio Settings for volume, mute, balance,
bass, treble, fade, microphone 
volume, and mono/stereo modes.

Projector Settings for front/rear projection and
the lamp-hours counter.
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Menu What it contains

Preferences Settings for colors, language, 
on-screen indicators, and Program key
functionality. Also contains the 
settings for projecting in reverse 
video for DOS screens.

Advanced Settings for custom profiles, horizon-
tal and vertical image position, VCO
gain, and sense lines.

The Tools menu

Option Function

Draw Mode Sets the background for Draw:
• Overlay (transparent)
• WhiteBoard (white background)
• BlackBoard (black background)

Draw Turns the Draw tool on and off.

Break Timer Starts the timer or turns it off.

Break Timer Value Sets the break timer interval, 
from 1-60 minutes.

Mouse Tracking Sets the speed of the mouse.
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Draw Mode Draw

WhiteBoard On

BlackBoard

Overlay Off

Break Timer

On

Off

Break Timer 
Value

15:00

Mouse
Tracking

Menus

Input Source

Cyclops

Advanced

Image

Projector

Tools

Audio

Preferences
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The Cyclops menu

Option Function

Calibrate Starts the Cyclops calibration 
procedure.

Button Sets the Cyclops wand or laser pointer
to emulate a left, right, or center 
mouse button (or none).
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Calibrate Button

Calibrate Right

None

No Calibrate Left

Center

Menus

Input Source

Tools

Advanced

Image

Projector

Cyclops
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Preferences
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The Input Source menu

Option Function

Source Select Select the input source:
• Computer
• Video 1
• S-Video 1
• Video 2
• S-Video 2
• Adobe Acrobat Player System (optional)

Source Mode Select from a list of video standards:
• NTSC
• PAL
• SECAM
• Computer compatibility

Input View projector readings for the 
Measurements selected input source:

•  VSync (vertical sync frequency)
•  HSync (horizontal sync frequency)
•  Lines (number of h-sync pulses

per v-sync)
•  Sense (monitor input sense line levels)
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Source Select SourceMode Input Measurements

Video 1 EWS1 (140 MHz) HSync:  0.00 KHz

Current Mode:

S-Video 1

Computer VSync:  0.00 Hz

Lines: 0 Sense: HHH

Video 2

S-Video 2

SelectCancel

EWS2 (130 MHz)

EWS3 (135 MHz)

1280 x 1024 81.25 KHz 76 Hz

1280 x 1024 81.97 KHz 76 HZ

1280 x 1024 80 KHz 76 Hz

Menus

Cyclops

Tools

Advanced

Image

Projector

Input Source

Audio

Preferences

Adobe Acrobat Player 
            System
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The Image menu 
(computer or 
Adobe Acrobat 
Player System 
input source)

Option Function

Sync* Adjusts the sync setting.

DotClk..* Adjusts the dot clock setting.

Bright Adjusts the brightness of the image.

Contrast Adjusts the RGB bias levels.

Red Adjusts the red level.

Green Adjusts the green level.

Blue Adjusts the blue level.

Factory Default Resets the source mode to the initial
factory settings.

Interlace Sets the interlace even/odd frame
assignment:

• Even sets frame 0 as even.
• Odd sets frame 0 as odd.

*Not available in Adobe Acrobat Player System mode.
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Bright ContrastSync DotClk.Menus

Cyclops

Tools

Advanced

Input Source

Projector

Image

Audio

Preferences

Green BlueRed Factory 
Default

Reset

No Reset

Interlace

Odd

Even
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The Image menu
(video or S-video
input source)

Option Function

Contrast Adjusts the video contrast.

Bright Adjusts the video brightness.

Tint Adjusts the video tint.

Saturation Adjusts the video color saturation.
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The Audio menu

Option Function

Volume Adjusts the audio volume.

Mute Mutes the audio or turns it back on.

Balance Adjusts the left/right audio balance.

Bass Adjusts the bass.

Treble Adjusts the treble.

Fade Adjusts front/rear audio balance.

Mic. Volume Adjusts the volume of the 
microphone.

Audio Mode Switches between Stereo and 
Mono modes.
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Balance BassVolumeMenus

Cyclops

Tools

Advanced

Input Source

Projector

Audio

Image

Preferences

Fade Mic.
Volume

Treble Audio
Mode

Mono

Stereo

Mute

Mute

Normal
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The Projector menu

Option Function

Projection Switches between front and rear 
projection.

Lamp Hours Resets the lamp hours counter.
Use this option after you change 
the lamp.

Lamp Hours Displays the number of hours elapsed
on the lamp-hours counter.
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Projection Lamp Hours Lamp Hours

Rear Reset

Front No Reset 65:25:54

Menus

Cyclops

Tools

Advanced

Input Source

Audio

Projector

Image

Preferences
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The Preferences menu

Option Function

Colors Sets the number of colors to use.

Language Sets the default language for the
menus.

On-Screen Displays or hides the slide bars for
sync, volume, contrast, tint, horizontal 
position, and vertical position.

Prog Key1 Sets an operation for the PROG 1 key 
on the remote control. Choose from 
the following options (described else-
where in this guide):

• SCALE
• Draw
• Reverse
• CLEAR
• Freeze
• Colors
• WhiteBoard
• BlackBoard
• Overlay
• Button right, left, center
• Title screen

Prog Key2 Sets an operation for the PROG 2 key 
on the remote control (same choices
as PROG 1 key).

Language

Deutsch

Français

English

Español

Italiano

Prog. Key1

Draw

Scale

Reverse

Freeze

Clear

Menus

Cyclops

Tools

Advanced

Input Source

Audio

Preferences

Image

Projector

Colors

Millions

226K

On-Screen

Hide

Display

Prog. Key2

Scale

Draw

Reverse

Freeze

Clear
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The Advanced menu

Option Function

User Sets a user profile of projector 
settings:

• Defaults
• User A (user defined)
• User B (user defined)

Hor. (Horizontal) Adjusts the horizontal position of the
Pos (Position) image on the screen.

Vert. (Vertical) Adjust the vertical position of the
Pos (Position) image on the screen.

VCO gain Sets the VCO gain parameter of 
the PLL. 

Sense 3, 2, Set the level of the four sense pins:
1, and 0 • High does not drive this pin

• Low drives the pin low
See Appendix C, Sense lines,
for more information

User

User A

User B

Defaults

Sense 3

Low

High

Horiz.
Pos.

Menus

Cyclops

Tools

Preferences

Input Source

Audio

Advanced

Image

Projector

Vert.
Pos.

VCO
Gain

Sense 2

Low

High

Sense 1

Low

High

Sense 0

Low

High
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Your Polaview Model 305 Projector comes with Polaroid F/X
software effects that you can use to make your presenta-
tions more interesting and effective. For example, you can
use the Spotlight to call attention to specific areas on the
image, use the Zoom or Magnify effects to focus on impor-
tant information in the image, or use See-it/Show-it to pre-
view images on your computer without distracting your
audience.

You can use Polaroid F/X with either the remote control that
comes with your projector or the optional Cyclops interac-
tive pointer system, or both at the same time.

Note: You can only run Polaroid F/X on Windows with IBM
PC systems and compatibles. It is not available for Macin-
tosh or UNIX systems.

Note: You cannot use Polaroid F/X with the Adobe Acrobat
Player System.
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To use Polaroid F/X, follow these steps:

1 Use the serial cable appropriate for your system 
(PCs: C936-6 or Macs: C470-6) to connect the serial port on
your computer to the CYCLOPS port on the projector.

2 Install the Polaroid F/X software.

3 Start Polaroid F/X, customize the effects, and assign them to
specific keys on the keyboard or to the remote-control keys.

4 Minimize the Polaroid F/X main screen. To start an effect
during your presentation, simply press the assigned key 

AUDIO OUT

MIC CYCLOPS

COMPUTER 
AUDIO IN



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
omPolaroid F/X 73

Getting started

Installing Polaroid F/X Follow these steps to install the Polaroid F/X software:

1 Insert the disk labeled Polaroid F/X into your computer flop-
py drive.

2 Complete this step as it applies to your specific computer
system:

• In Windows 95, choose Start, Run, then type a:\setup.exe 
(or the drive letter for your floppy drive).

• In Windows 3.x, choose File, Run, then type a:\setup.exe 
(or the drive letter for your floppy drive).

3 Follow the on-screen instructions.

Starting Polaroid F/X After installing the software:

• In Windows 3.x or Windows 95, double-click on the 
Polaroid F/X icon to start the program. 

The first time you start the software, Polaroid F/X displays a
Projector Setup Tutorial (Wizard). Follow the instructions
that appear on your screen. When you finish configuring
your system, restart Windows.
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The main screen of the F/X program appears:

Polaroid F/X special
effects

On the left side of this window is a list of the special effects.
The Assignments area in the middle of the window offers
options that let you customize your remote control and soft-
ware.

Note: Opening a menu or using the Draw tool suspends
operation of Polaroid F/X.
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Using Polaroid F/X

The Assignments area The Assignments area displays the custom remote-control
keys and their current assignments. To modify the custom
remote-control keys:

1 Highlight the effect you want to assign.

2 Double-click on the box next to the customer remote-control
key in the Assignments area.

The Assignments area also contains the five following but-
tons:

Button Function

Setup Remote Lets you switch the assignments 
display between the remote 
control (included) and the optional 
Cyclops wand or laser pointer.

Put Away Minimizes the F/X screen.

Edit Effect Allows you to assign a shortcut key 
to the effect. You can also use this 
option to customize an effect.

Projector Setting Allows you to adjust image, audio,
and general settings on your 
projector.

Connect Allows you to choose the COM
port to which you plan to connect 
your projector.

In addition, the Assignments area allows you to control the
MouseDisk speed on your remote control, and gives you
check-boxes to turn on audible and visual feedback.
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Customizing effects Options are available to let you tailor most effects to meet
specific presentation requirements. For example, you can
customize the Spotlight effect to specify the shape and size
of the spotlight. You can also change the name of each
effect (for example, you can change the name from “Spot-
light” to “Headlight”).

You can assign each effect to a key on the keyboard or to a
remote-control key. Use this key to start the effect.

To customize an effect:

1 Right-click on the name of the effect and choose Edit from
the menu. You can also select the desired effect and click on
the Edit Effect button to make your changes.

2 Adjust the settings in the appropriate dialog box and click
OK.

3 When you finish customizing the effect, choose File and
Save to save your settings.

4 Click on the control box in the upper left corner to minimize
the Polaroid F/X main screen.

Note: To gain access to effects assigned to the PROG 1 and
PROG 2 keys, assign the settings for those keys to Host (in
the Preferences menu of the projector). 
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Using the Cyclops You can use the Cyclops interactive pointer system with 
interactive pointer Polaroid F/X. To set up the software, click on Setup 
system Remote in the Assignments area of the main screen.

Choose Cyclops Wand or Laser Pointer. The following
screen appears:

The Cyclops 
interactive pointer 
screen

Click on the Show Navigation Bar check-box to enable the
navigation-bar feature. The navigation bar offers you a quick
way to scroll through your slide show with the Cyclops
wand or laser pointer.
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Click on the Edit Navigation Bar button. The following
screen appears:

Edit Polaroid 
Navigation Keys 
screen

Use this screen to assign different functions to the naviga-
tion bar. To assign a new function to the navigation bar,
click on the Next or Previous areas and a select a function,
using the list boxes to the right.

You can also use this screen to determine where the naviga-
tion bar appears on your display. The default is Lower Left.
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See-It/Show-It See-It/Show-It is a feature of Polaroid F/X that lets you freeze
your projected image while you preview the next image on
your computer monitor.

To use See-It/Show-It:

1 Click Edit Navigation Keys in the Assignments area of the
Polaroid F/X main screen. The following screen appears:

Edit Navigation 
Keys screen

2 Select a countdown time for the Forward or Reverse (Next:
and Previous:) keys, or both. When you select a countdown
time, you automatically disable See-It/Show-It.

3 To disable See-It/Show-It, select None from the Forward and
Reverse key list boxes.

To switch to See-It/Show-It, press the Forward or Reverse
key once quickly. To end See-It/Show-It, press the Forward
or Reverse key a second time. The counter disappears and
the next image appears immediately.
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Freeze The Freeze option freezes the image on your projector so
you can use your remote control to control your computer.
This feature lets you work on your computer without dis-
tracting your audience’s attention away from your presenta-
tion. To edit the Freeze key settings, click the Edit Freeze Key
option in the Assignments area. The following screen
appears:

Edit Freeze Key screen

To use Freeze:

1 Press Pause on your remote control.

2 Use any of the remote control keys to control your computer.

3 Press Pause again when you are ready to return to your pre-
sentation.
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Once you freeze your screen, all keys on your remote con-
trol are available to control you computer. You can edit your
current presentation, display slides from another presenta-
tion, or open another application—all without distracting
your audience.

Note:  If you adjust the projector settings from your com-
puter while you are in Freeze mode, your changes do not
display until you exit Freeze mode.

Starting an effect Once you customize an effect, you are ready to use it. 

1 Before the presentation, start Polaroid F/X, then minimize
the main screen.

2 During your presentation, press the key or button you
assigned to each effect to start the desired effect.

The Presentation The following are the Presentation effects. To end any of
effects the effects, press the Esc key on your keyboard or the key

on the remote control that you assigned for that effect.

Break Timer is a digital timer that counts down from a
duration you set. Once you start the timer, click the
MouseDisk once to lengthen the duration.

You can also use Break Timer to play a sound or select a
background color or picture. If your computer is equipped
with a sound card, you can select a WAV file and play it con-
tinuously while the timer is running, or use it as an alarm
that sounds when the timer expires.

Center Cursor centers the mouse pointer on the screen.
This helps prevent “losing” the cursor.

Custom Cursor changes the appearance of the mouse
pointer to one of 30 images. Only the standard arrow point-
er changes. The other standard icons (such as the hour-
glass) are not affected.
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Detail Cursor magnifies the area around the pointer in a
small rectangle.

Effects Menu displays a list of effects. Use this feature to
start effects not assigned to a button or key. To start an
effect, double-click its name. Press Esc on the keyboard to
close the list without starting an effect.

Highlight Bar draws a horizontal bar across the screen.
Move the bar up or down to draw attention to different
areas on the screen. You can also change the color and
width of the bar.

Highlighter works like a highlighter pen on your computer
screen, by overlaying a semi-transparent color on your
screen. You can change the color and width of the “pen.”

Magnify enlarges a rectangular area around the mouse
pointer. You can choose from three levels of magnification
(200 percent, 400 percent, or 800 percent).

Note: To enlarge the entire screen, use the Zoom effect.

Next/Previous advances to the next or previous slide.

Object allows you to draw rectangles, squares, ellipses, and
circles. You can change the color and width of each shape.

Refresh repaints the projected image. Use this feature to
erase “remnants” of Stamp and Telestrator effects.

Reveal hides the image, then lets you incrementally reveal
more and more of the image. You can specify a color for the
hidden area, a horizontal or vertical effect, and the size of
the Reveal window.

Run Program starts a program that you choose.

Screen Blank blanks the screen to a color that you choose.

Sound plays a WAV file when you press a button. You can
play the sound repeatedly or just once.

Note: You must have a sound card to use this effect.
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Spotlight dims all of the image except for the area around
the mouse pointer. You specify the shape and size of the
spotlight (circular, square, or bar). Once you start Spotlight,
press the MouseDisk to change its size. Another setting
makes the Spotlight visible against a black background.

Stamp allows you to choose from 15 bitmaps to “stamp,”
or paste, over the projected image. You can choose to play
a sound each time you stamp.

Switch to F/X switches to the Polaroid F/X main screen.

Telestrator turns the mouse into a freehand drawing tool.
You can customize the color and width of the line and “con-
strain” the drawing to only horizontal or vertical lines.

Ticker Tape displays a scrolling text message across the
image. Just specify the text of what you want to appear, the
typeface, and the point size. You can play a sound file each
time the message runs across the image, and customize the
background color and picture.

Title Screen projects an image from a BMP file. You can
use this effect to show a predefined image with transition
effects during a presentation. You can also play an associat-
ed sound. Just specify which file to play and indicate
whether to play it when the image appears or continuously.

Zoom enlarges the entire image to 200 percent, 400 percent,
or 800 percent of its original size. You choose whether to
show the mouse pointer during a Zoom and indicate the
level of magnification. If you check the Show Cursor During
Zoom check box, click on the left mouse button to cancel
the zoom. If you and the right mouse button to perform a
mouse click .

Note: Most effects have an option that lets you rename the
command itself.
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Menu commands File menu

The File menu offers the following commands for working
with profiles of effects.

Menu item Function

Reset to defaults Resets the F/X options to the factory
defaults.

Open Opens a previously-saved profile of
settings.

Save Saves recent changes to the current
profile (prompts for a name if the file
has not been named).

Save As Saves the profile settings under a
name and location you specify.

Exit Quits the F/X program.

Effects menu

The Effects menu lets you change the items in the effects
list.

Menu item Function

Edit Allows you to edit F/X options.

Test Tests the current effect.

Add Allows you to add an effect.

Duplicate Allows you to copy an effect.

Delete Allows you to delete an effect.
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Options menu

The Options menu offers commands that allow you to set
up assignments on the remote control, wand, or laser point-
er; change the look and feel of the cursor; and change the
COM port settings.

Menu item Function

Show Remote Allows you to display the assignments 
area for the remote control or the 
optional Cyclops wand or laser 
pointer.

Cursor Options Changes the look and feel of the 
cursor. Also includes an option that
lets you apply one of the Polaroid F/X 
custom cursor options to Windows.

Connect Allows you to edit the COM port 
settings for your computer.
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Periodic maintenance keeps your projector in top working
condition.

Cleaning the lens and mirror

To clean the projection lens and mirror: 

1 Take a piece of lens tissue and form it into a loose swab.
Wet it with lens cleaning fluid or denatured alcohol, and
gently wipe it over the surface of the lens or mirror.

2 Take another clean piece of lens tissue and repeat the
process, wiping it over the lens or mirror in the opposite
direction.

Repeat this process until you can no longer detect smudges
or particles on the lens. Do not look directly into the lens
when the lamp is on!

Caution: Do not use acetone to clean the lens; it may
remove paint from areas around the lens or mirror and
leave a residue on the glass.

5 Maintenance



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
om

Cleaning the projection window

The projection window is the surface through which the
LCD image is projected. To ensure that the projector main-
tains a clear, sharp image, you should clean the projection
window from time to time.

To clean the surface of the projection window:

1 Use a can of compressed air to blow dust off the LCD panel
inside the projector. Point the can into the opening in the
top center of the right side of the projector (see the illustra-
tion below).

Blowing air into 
the projector

2 Take a piece of lens tissue and form it into a loose swab.
Wet it with a solution of approximately ten percent Iso-
propyl alcohol and water, and gently wipe it over the sur-
face of the projection window.

3 Take another clean piece of lens tissue and repeat the
process, wiping it over the projection window in the oppo-
site direction.

4 Repeat if necessary.

Caution: Do not use lens cleaning fluid to clean the projec-
tion window. It may damage the surface.
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Replacing the lamp

For best performance, you should replace the lamp after 700
hours of operation.

Note: Do not touch the lamp with your bare hands. Use
gloves or a soft cloth and handle it using the metal ends
only.

Removing 1 Leave the projector running with the lamp off for at least 
the old lamp five minutes before you change the lamp. This allows the

fan to cool the lamp chamber.

2 After the lamp has cooled sufficiently, turn off the projector
and unplug the power cord. (As a safety feature, you cannot
open the lamp chamber until you disconnect the power
cord )

3 Slide the AC lock button in the direction of the arrow. You
cannot move this button until you disconnect the power
cord from the projector.

4 As you slide open the AC lock button, remove the left side
cover by sliding it about 1/4 of an inch to the left. When the
cover releases, pull it straight off.

Sliding the 
rear panel off 
of the projector
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5 Locate the door to the lamp chamber on the right side of the
left panel. It has one slotted, captive screw. With a screw-
driver or coin, loosen the screw, then open the lamp-cham-
ber door.

Opening the 
lamp-chamber door

6 Locate the thumbscrew on the right side of the lamp and
unscrew it. When the thumbscrew is loose enough, gently
pull the lamp from the right socket. Then slide it out from
the left.

Installing Caution: Make sure to wear gloves or use a soft cloth to 
the new lamp handle the new lamp. Never touch the lamp with your bare

hands, as this can significantly shorten the life of the lamp. 
If you do touch a portion of the lamp with your bare hands,
wipe it off with a soft cloth moistened with denatured 
alcohol.

To install a new lamp: 

1 Remove the lamp from the package.

2 The lamp has thumbscrews on both ends. Remove the
thumbscrew from the end of the lamp that has no printing.
Discard the thumbscrew.
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3 Slide the end of the lamp without the thumbscrew into the
slot on the left side of the lamp chamber (see below).

Sliding the lamp into
place

4 Slide the end of the lamp with the thumbscrew into place,
with the glass pinch-off on the lamp pointing up, and tight-
en the thumbscrew. Make sure to tighten the thumbscrew
as snugly as possible. Pull the lamp to make sure that it is
securely seated.

5 Close the lamp-chamber door and tighten the captive screw.
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Cleaning/changing air filters

To make sure that your projector operates safely and effi-
ciently, you should change or replace the filters after every
250 hours of operation. It is best to change or clean all of the
filters at one time. To clean the filters, wash them in a solu-
tion of warm, soapy water.

Your Polaview Model 305 Projector has three air filters.

Access to the top filter To gain access to the top filter:

1 Remove the left side door, as described in the previous sec-
tion.

2 Unscrew the three screws located at the top of the left side
area (see the illustration below).

The three left-top
retaining screws

3 Unsnap the top left cover by lifting it up and pulling it out
(see the following illustration).
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Lifting the top 
left cover out

The filter is located on the inside of the top left cover (see
the illustration below).

The top cover filter

4 There is a plastic grill covering the filter. Pull on the handle
in the center of the grill to access the filter.

To replace the top cover, reverse steps 1 through 3, taking
care to align the cover before snapping it into place.

Access to Before you can gain access to the right filters, you must
the right filters remove the left side door and top left cover. See steps 1

through 3 in the previous section for more information.
To gain access to the right filters:

1 With the projection arm down and locked, turn the projector
on its side, with the handle facing up.
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2 Locate the screws on the bottom side of the right panel.
Loosen the three screws (see the illustration below).

3 Turn the projector back to its base and raise the projection
arm.

4 Locate the screws holding the main top cover in place (see
the illustration below). Remove the three screws and lift up
on the screw mountings until the cover is loose. Gently pull
the cover up and to the left of the projector until it releases.

The three top-cover
screws

5 While still holding the cover, remove the ribbon cable on the
underside of the control panel. Place the cover on a soft
cloth.

94 Maintenance

OVERTEMP

VOLUME

SOURCE FIT-TO-VIEW POWERCLEAR

SETUP

MENU

REPL   LAMP



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
om

Caution: Never touch the LCD panel located underneath 
the top-cover projection lens. Use caution when changing
the filters.

6 Locate the three screws at the top of the right side panel
(see the illustration below). Remove the screws and unsnap
the panel, from the rear first.

The screws at the 
top of the right 
side panel

7 The filters are now exposed (see the illustration below).

The two right 
side filters

Remove the retaining screw to gain access to the filters. Pull
the front filter out

To replace the covers, reverse steps 1 through 5, taking care
to align the top and side covers. Make sure to reattach the
ribbon cable before you replace the top cover. The ribbon
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cable is keyed, so it only reattaches on one side. Also, make
sure that the arm release lever is in the release position
(fully to the left) before you replace the top cover.

Replacing the batteries in the remote control

1 Locate the battery compartment on the end of the remote
control. Press down while you slide the cover off of the
compartment.

2 Remove the old batteries and replace them with new ones.
Make sure you align the batteries in the proper direction.

3 Slide the cover back onto the battery compartment, snap-
ping it into place.

Temperature extremes

Do not store your projector in temperatures in excess of
140˚F (50˚C). The maximum operating temperature is 80˚F
(27˚C).

If you happen to expose the projector to extremely cold
temperatures, you should let it warm up to room tempera-
ture before you begin your presentation. In general, the rec-
ommended maximum operating temperature drops 1˚C for
every 1000 feet (305 meters) above sea level.
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This chapter provides answers to some commonly asked
questions about the Polaview Model 305 Projector.

Please refer to the troubleshooting chart before calling your
dealer for assistance.

Troubleshooting guide

Symptom Cause Solution

No computer image Loose cable Check and secure cable
projected connections

No power to computer Turn on computer

Incompatible video If possible, check computer
system with another monitor

No power to projector Power switch; AC cord 
plugged in (both ends);
outlet on

External video port not Activate the external video
activated port on your notebook 

computer. Cycle the power 
on your notebook computer 
with your projector
connected and turned on. 

6 Troubleshooting
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Symptom Cause Solution

No image on Loose cable Connect cable
computer screen Wrong video cable Use correct video cable

BNC cable not connected Make sure cable is correctly
correctly attached at both ends

Monochrome on color Computer was turned Turn projector on 
monitor on before projector Restart computer

Streaks on monitor Video cable plugged into Check and reset cable
computer is upside-down connections

Faint screen Low contrast Adjust CONTRAST

Jittery, fuzzy letters Out of sync Adjust SYNC control

Image off center Position controls Adjust position controls; if
(arrow keys) or the image does not center, check
Hpos/Vpos controls for compatibility problems
in the menus

Cannot get entire image The default resolution Press the SCALE key to
on screen; scrambled for all images larger than see the entire image, or use
image 1024 x 768 is 1024 x 768 the arrow keys to pan the

image

Compatibility problems Make sure your system is
compatible with the
standards listed in
Appendix A, Specifications

Black border appears The full 800 x 600 image The projector is functioning
around 800 x 600 images is displayed in 1024 x 768 normally. Disregard.

mode. The black area is
not used.

Image appears to have Incorrect interlace signal Select the opposite interlace
lines “swapped” selected signal (even/odd)
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Symptom Cause Solution

One or more colors SYNC, BRIGHTNESS, Adjust SYNC, BRIGHTNESS 
“shimmer” on-screen or CONTRAST is out of or CONTRAST settings

adjustment

No video image Video source(s) Check video source(s)
projected (composite or S-video) for

power and proper
operation

Loose/improper cabling Secure cabling between
video source(s) and panel

Colors weak in video Video source(s) Check for faulty video source,
(NTSC/PAL/SECAM) bad connection, or frayed
mode cable

CONTRAST setting Adjust CONTRAST level
may be too low

Getting excess white or Video signal level Adjust CONTRAST level
washout in video mode too high

Black and white Ambiguity in Activate Input Source menu
image from color video signal and select SECAM as the 
SECAM input video source mode

Remote control Batteries upside-down Check battery placement or
does not work or old replace with new batteries

Tiny dim or colored This is a normal LCD None
points of light LCD effect

Over-temp light is Airflow is blocked Ensure that the shorter sides
illuminated are unobstructed. Cycle the

power and try again

Filters are clogged Clean or replace filters

Fan is malfunctioning Projector needs service
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Symptom Cause Solution

Rainbow image Lamp pinch-off not Adjust lamp position to
pointing up point pinch-off straight up

Ensure that thumbscrew
is very tight

Discolored image Lamp is not seated Adjust lamp to ensure it
properly is firmly seated in the clamps

Ensure that thumbscrew 
is very tight

Polaview Model 305 Projector parameter adjustments

If the auto-selected computer source parameters are incor-
rect for your application, or the computer system you are
using is not one of the many stored in the Model 305 (refer
to the Compatibility list later in this chapter), it may be pos-
sible to select a closer source mode.

1 Open the Polaview Model 305 Projector Input Source Menu
and record the H Sync and V Sync values in the Input Mea-
surements window for the incoming video signal. 

Input Measurements
window

2 If possible, consult your computer technical documentation
for your system Video Data Rate (dot Clock) specifications.

3 After you determine your video specifications, find the clos-
est computer parameter entry in the compatibility list. Next,
open the Polaview Model 305 Projector Source mode menu
and scroll up or down through selections to find the closest
source mode. Use the right arrow key to load the mode of
choice.

100 Troubleshooting
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Further parameter adjustments may be required to correct
image problems for the best input source selection. A basic
explanation of the adjustment functions follows.

Note: Parameter modifications are saved each time you
close the menus or turn off the power.

Adjusting contrast Adjust the contrast so that the colors (particularly the gray 
and brightness shades) are right for the projected image. Buttons should

look three-dimensional, as they do on your monitor. Adjust
the Brightness to make the image clear.

Adjusting sync Adjust the SYNC control to shift the dot clock phase to
match the phase of incoming video signal. An incorrect sync
setting causes “sparkles” and horizontal streaks randomly
across the screen.

Adjusting The Dot Clock control adjusts the projector dot-clock 
the dot clock frequency to match the incoming video signal frequency.

An incorrect dot clock adjustment causes faint, uniformly-
spaced vertical lines of video distortion/shading.

Adjust the Dot Clock control slowly in the direction that
causes the lines/bands of shading to get wider and fewer in
number. There are no bands of distortion/shading when
correctly adjusted. 

Adjusting the The Hor. Pos. (horizontal position) control adjusts the 
horizontal position amount of blanking before each horizontal line. Incorrect

horizontal position adjustment can cause either side of
the projected image to extend beyond the viewing area,
end-of- line wrap around, or a half-normal display size.

Adjusting the The Vert. Pos. (vertical position) control adjusts the amount 
vertical position of blanking before each video frame. Incorrect vertical posi-

tion adjustment can cause the projected image to extend
above or below the viewing area, video-frame overlap (lines
from the bottom of one frame superimposed on the top of
the next frame, or a horizontal or vertical double image).
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Adjusting The Voltage Control Oscillator (VCO) gain affects how well 
the VCO gain the Dot Clock locks to the incoming horizontal sync signal.

Incorrect VCO gain is indicated by lines shooting through
the display or by severely compressed or shifted displays.

Adjusting your display

Horizontal Adjusting the Horiz. Pos control usually corrects this 
double image problem.

Adjusting the 
horizontal position

Use the arrow keys on the control panel, the SETUP key, or
the following procedure:

1 Press the MENU key to display the Main menu.

2 Select Advanced. 

3 Select Horiz. Pos. (horizontal position).

4 Press the down arrow key until the image is properly
aligned.

Note: There are separate vertical position values for 
NORMAL and SCALE modes. Adjustments in one mode are
not made in the other.
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Half-normal height display

Adjusting the 
half-normal height 
display

Use the arrow keys, the SETUP key on the control panel, or
use the following procedure to adjust the half-normal height
display:

1 Press the MENU key to display the Main menu.

2 Select Advanced from the Main menu.

3 Select the Hor. Pos. (horizontal position) slide bar.

4 Press the down arrow key until the image is properly
aligned. (If this adjustment does not correct the problem,
reset the Hor. Pos. control.)

Note: There are separate Hor. Pos. and Vert. Pos. values
for NORMAL and SCALE modes. Adjustments in one mode
are not made in the other.

5 Press the right arrow key to select the Vert. Pos. (vertical
position) slide bar.

6 Press the down arrow key until the image is displayed prop-
erly. (If this adjustment does not correct the problem, reset
the Hor. Pos. control to the default.)

If neither parameter corrects the problem, you must find the
correct Dot Clock value to prevent image distortion. Make
changes to this parameter slowly to avoid skipping over the
desired value. This may require some trial and error.

7 Select IMAGE on the Main menu.

8 Select the Dot Clock slide bar with the right arrow. 
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9 Move the slide bar up or down until the image is displayed
properly. 

If none of these adjustments corrects the problem, try a dif-
ferent Source mode selection. Make sure the selection has
the correct resolution and the closest V-sync and H-sync val-
ues.

Vertical double image

Adjusting the 
vertical position

Use the SETUP key or the following procedure to adjust the
Vert. Pos. control.

1 Open the Main menu.

2 Select Advanced. 

3 Select Vert. Pos. (vertical position).

4 Press the down arrow key until the image is properly
aligned.

Note:  There are separate Vert. Pos. values for Normal and
Scale modes. Adjustments in one mode are not made in the
other.

If this adjustment does not correct the problem, try a differ-
ent Source mode setting. Make sure the selection has the
correct resolution and the closest V-sync and H-sync values.
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Faint, vertical lines 1 Use the remote control to adjust the sync first. If the 
of distortion lines of distortion move uniformly across the screen as you

adjust the sync, there is a dot clock problem. 

2 Adjust the dot clock slowly so that the shading gets farther
and farther apart, until it is gone. This may require trial and
error as you must avoid skipping over the correct value.

Dark, vertical lines You may detect dark, uniformly-spaced vertical lines 
of distortion (sometimes with smaller lines on either side of each dark

line) in Scale or Normal mode, or both. Any of the following
steps may eliminate this problem.

Dark Lines in Scale mode only

1 With the menus closed, use the arrow keys on the control
panel or the MouseDisk on the remote control to pan the
image down until it stabilizes.

2 Adjust the contrast.

3 Change the colors to 512.

4 Change the computer-screen background colors; certain col-
ors may cause this pattern to appear in Scale mode.

Dark lines in Normal mode only

1 Adjust the contrast.

2 Change the colors (Preferences menu; Colors) to 512.

3 Change the computer screen background colors; certain col-
ors may cause this pattern to appear in Scale mode.
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Noise, flickering 1 Use the remote control to adjust the sync first. Make 
pixels, or distortion sure you use the entire range of sync adjustments before yo

proceed to step 2. You can correct many severe-looking dis-
tortions by using sync.

Note:  There are separate sync values for NORMAL and
SCALE modes. Sync adjustments made in one are not
applied to the other. Make adjustments in both.

2 If sync does not correct the problem, adjust the Dot Clock.
Make changes to this parameter slowly to avoid skipping
over the desired value. This may require some trial and
error.

3 If the problem still exists, adjust the VCO gain.
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Unknown/Unrecognized video source 

Occasionally, you may encounter an unknown or unrecog-
nizable video signal while using the projector. If this should
happen, use the following steps to connect and adjust the
projector:

1 Connect the projector to the video source and make sure
that the power is on.

2 Select User A or User B for a custom setting (Advanced
menu).

3 If it is not already selected, select Computer input from the
Source menu.

4 Check the Input Measurements window and record the V
Sync, H Sync, and Lines values for the incoming video sig-
nal. Consult your computer documentation for the Video
Data Rate (dot clock) specifications.

Input measurement 
window

Note:  The Lines value is larger than the vertical lines of
data displayed. This is due to additional vertical lines that
are sent by the video system for video processing timing
purposes.

5 In the Source mode menu, select the source mode closest to
the values recorded in the preceding step.

6 Make adjustments as necessary to fine-tune your display.

7 Close the menus to save these settings.

Troubleshooting 107

Input Measurements
V Sync: 72.00 Hz
H Sync: 78.00 KHz
Lines: 1057 Sense: HLHL



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
om

Compatibility list

The following pages list the workstation/computer video
signal characteristics stored in the Polaview Model 305 Pro-
jector memory.

This list is subject to change as more platforms are support-
ed. If your system is not listed, call Polaroid for more infor-
mation.

Model/Video Dot Clk H Sync V Sync
Label Manufacturer System Resolution (MHz) (KHz) (Hz)

EWS1 SGI Indy, Indigo2, 1280 x 1024 140 81.97 76
XL, XZ, Extreme

EWS2 Intergraph TD-2, TD-4, 1280 x 1024 130 81.25 76
TD-5, G90

EWS3 Generic 1280 x 1024 135 80 76

EWS4 Sun SPARC 2, GX, 1280 x 1024 135 80 76
Turbo GX

VESA Generic 1280 x 1024 134.3 78.43 74

EWS5 HP 735/125, 735 1280 x 1024 135 78 72

VESA Generic 1280 x 1024 128 77 72

EWS6 DEC 3000/300 1280 x 1024 132.6 76.8 72

EWS7 SGI Indy, Indigo2, 1280 x 1024 130 76.9 72
XL, XZ, Extreme

EWS8 Sun SPARC2 GX+ 1280 x 1024 117 72 67

EWS9 DEC 3000 1280 x 1024 119.8 70.3 66

EWS10 Tadpole SPARCbook 3 1280 x 1024 111.77 64.5 60

VESA Generic 1280 x 1024 114.6 64 60

EWS11 IBM RS6000 1280 x 1024 111.5 63.36 60

* Denotes interlaced models
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Model/Video Dot Clk H Sync V Sync
Label Manufacturer System Resolution (MHz) (KHz) (Hz)

EWS12 SGI Indy, Indigo2, 1280 x 1024 107.35 63.9 60
XL, XZ, Extreme

EWS13 Intergraph TD-2, TD-4, 1280 x 1024 106 63.8 64
TD-5, G91

MAC Apple Power PC 1280 x 1024 135 80 75

MAC Apple 1280 x 960 63 75 75

EWS14 Tadpole SPARCbook 1152 x 900 105.5 71.8 76

EWS15 Tadpole SPARC 2 1152 x 900 105.5 71.8 76

EWS16 Sun SPARC 2 1152 x 900 100 71.7 76

VESA Generic 1152 x 900 106 70 74

MAC Apple Quadra 605, 1152 x 870 100 69 75
PowerMac

VESA Generic 1152 x 900 103.8 68 72

EWS17 Sun SPARC 2 GX, GX+ 1152 x 900 94.5 62 67

EWS18 Tadpole SPARCbook 3 1152 x 900 93 62 66

EWS19 NeXT NeXT station 1152 x 870 98.8 60.6 68

VESA Generic 1152 x 864 109.4 76 80

VESA Generic 1152 x 900 85 55.5 60

EWS25 Sun SPARC 2 Turbo GX1152 x 900 94.5 61.7 66

VESA Generic 1152 x 900 98.8 66 70

EWS20 Intergraph TD-2, TD-4, TD-5, 1024 x 768 104 81.25 99.328
G90, G91

VESA Generic 1024 x 768 80 63 75

* Denotes interlaced models
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Model/Video Dot Clk H Sync V Sync
Label Manufacturer System Resolution (MHz) (KHz) (Hz)

VESA Generic 1024 x 768 84.5 62.5 78

EWS21 Tadpole SPARCbook 3 1024 x 768 81.3 61.2 76

MAC* Apple PowerPC 1024 x 768 80 60 75

XGA Apple Quadra 605 (19”), 1024 x 768 74.7 56.4 70
PowerMac

XGA Generic 1024 x 768 80 53.3 67

VESA Generic 1024 x 768 64.3 48.88 60

VESA Generic 1024 x 768 77.3 58.1 72

VESA Generic 1024 x 768 65 48.5 60

EWS22 SGI Indy, Indigo2, 1024 x 768 64.3 48.88 60
XL, XZ, Extreme

EWS23 HP 735/125, 735 1024 x 768 65 48.5 60

EWS24 RDI RDI Lite 1024 x 768 50 46.5 60

VESA Tadpole SPARCbook 2, 1024 x 768 65 47.5 60
SPARCbook 3

VESA Generic * 1024 x 768 50 37.8 46

Laptop Toshiba T4500C* 1024 x 768 45 35.4 43

8514A IBM 8514A* 1024 x 768 43.6 34.5 43.5

Laptop Toshiba 2150 CDT 1024 x 768 44 35.4 43

MAC Apple 1024 x 768 80 60 75

SVGA Apple MAC 800 x 600 51 48.14 72

VESA Generic 800 x 600 40 37.9 60

Laptop Tadpole SPARCbook 3GX 800 x 600 36.3 36 57.5

* Denotes interlaced models
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Model/Video Dot Clk H Sync V Sync
Label Manufacturer System Resolution (MHz) (KHz) (Hz)

VESA Generic 800 x 600 36 35.16 56

SVGA Apple MAC 800 x 600 36 35.24 56

Laptop Toshiba T4500 800 x 600 36.7 35 56.4

VGA Generic 640 x 480 25 31.5 60

VGA Generic 640 x 480 31.5 38 72

VGA Generic Text Mode 720 x 480 25 31.5 70

VGA Toshiba 2150 CDT 640 x 480 25 31.9 60

VGA Generic 640 x 480 32 38 75

VGA Toshiba 2150 CDT 800 x 600 40 39 62.5

MAC Apple 832 x 624 57.3 49.73 74.5

MAC Apple LC 640 x 480 31.4 35 67

MAC Apple 13” 640 x 480 30.3 35 66

VGA Apple MAC 640 x 480 30 34.7 66

VGA Generic 640 x 480 25 31.5 60

VGA Tadpole SPARCbook 2, 640 x 480 25 30.65 59.3
SPARCbook 3

* Denotes interlaced models
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Where to get help

If at any time you need help with your projector:

1 Check the Troubleshooting Chart.

2 Call your dealer’s technical support line and explain your
problem.

3 Call Polaroid Corporation (see pages 113-114).
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Polaroid Offices and Service Centers

Australia
Polaroid Australia Pty. Ltd.
13–15 Lyonpark Road
P.O. Box 163
North Ryde, N.S.W. 2113
Tel.: (02) 9 950 7000
Fax: (02) 887 2209

Belgique/België
Polaroid (Belgium) N.V.–S.A.
Rue Colonel Bourg 111
Kolonel Bourgstraat 111
1140 Bruxelles–1140 Brussel
Tel.: 32 2 702 86 20
Fax: 32 2 726 92 99
Toll free: 32 78 155 905

Brasil
Polaroid do Brasil Ltda.
Av. Paulista, 1776–11º andar
Cerqueira Cesar
São Paulo–Capital
01310-921
Tel.: 55.11.285.6411
Fax: 55.11.283.2625

288.6521
287.5393

Canada
Polaroid Canada Inc.
350 Carlingview Drive
Etobicke, Ontario M9W 5G6
Toll free: 1-800-268-6970

Danmark
Polaroid a.s.
Blokken 75
3460 Birkerød
Tlf.: 42 81 75 00
Fax: 42 81 70 26

Deutschland
Polaroid GMBH
Sprendlinger Landstrasse 109
63069 Offenbach
Tel.: 069 8404 1
Fax: 069 8404 204

España
Polaroid (España), S.A
Calle Orense, 16
2a planta
28020 Madrid
Tno: 34-1-597.02.52
Fax: 34-1-597.27.82

France
Polaroid (France) S.A.
B.P. 7
78996 Elancourt Cédex
Tel.: (1) 30 68 38 38
Fax: (1) 30 68 38 39

Hong Kong
Polaroid (Far East) Ltd.
32/F Windsor House
311 Gloucester Road
Causeway Bay
Tel.: (852) 2894 0333
Fax: (852) 2895 1382

Italia
Polaroid (Italia) S.p.A.
Via Piave 11
21051 Arcisate (Varese)
Tel.: 0332-470031
Fax: 0332-478249

Japan
Nippon Polaroid
Kabushiki Kaisha
Mori Building No. 30
Toranomon 3-2-2
Minato-ku
Tokyo 105
Tel.: 81-3-3438-8811
Fax: 81-3-3433-3537

México
Polaroid de México S.A. de C.V.
Paseo de la Reforma 195
Piso 17
C.P. 06500 México, D.F.
Tel.: 703-1111
Fax: 566-0505
Del interior al 91 (800) 70-727
Ventas 91 (800) 70-747

Nederland
Polaroid Nederland B.V.
Zonnebaan 45
3606 CH Maarssen
PO Box 1219
3600 BE Maarssen
Tel.: 31-30-2-410-420
Fax: 31-30-2-411-969

Reparaties:
Polaroid (Europe) B.V.
Hoge Bothofstraat 45
7511 ZA Enschede
Tel.: 31-53-4-865-400
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New Zealand
Polaroid New Zealand Ltd.
Camera Services
24-26 Anzac Avenue
Auckland
Tel.: (09) 377 3773

Norge
Polaroid (Norge) A/S
Industriveien 8B, 1473 Skårer
Postboks 80, 1471 Skårer
Tlf:   67 90 47 10
Fax: 67 90 51 73

Österreich
Polaroid Ges.m.b.H.
Eitnergasse 5A
1231 Wien
Tel.: 869 86 27
Fax: 869 81 00

Portugal
Polaroid (España) S.A.
Sucursal em Portugal
Edificio Monumental
Avenida Praia da Vitória, 71-A 4º B
1050 Lisboa
Tel.: (01) 316.10. 52

Puerto Rico
Polaroid Caribbean Corporation
Centro de Seguros
Have. Ponce de León 701
Miramar, Santurce 00907
Tel.: (809) 725-6240
Fax: (809) 725-5462

Schweiz/Suisse/Svizzera
Polaroid AG
Hardturmstrasse 133
8037 Zürich
Tel.: (01) 277.72.72

Suomi
Polaroid Oy
Sinikalliontie 10
02630 Espoo
Puh: 90-502 35 33
Fax: 90-502 35 50

Sverige
Polaroid AB
Ekholmsvägen 34
Box 204
127 24 Skärholmen
Tel.: 08-710 08 50
Fax: 08-740 73 68 

U.K.
Polaroid (U.K.) Ltd. &
Polaroid Export Operations
Wheathampstead House
Codicote Road
Wheathampstead
Hertfordshire AL4 8SF
U.K.
Tel: (44) 1582 632000
Freefone: 0800 010119

U.S.A.
Polaroid Corporation
Technical Assistance
Tel.: Toll free 1-800-432-5355
Call for the nearest Polaroid 
location
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One Year Warranty

Polaroid Corporation warrants your Polaview Projector
equipment against defects in manufacture for a period of
one year from the date of purchase. To verify the warranty
period, you should keep the sales slip or other proof of the
purchase date.

Should this product, or any component or accessory 
included with it, become defective at any time during the
warranty period, Polaroid Corporation will, at its discretion,
either replace or repair this item, without charge, provided
the product is returned to a designated servicing location
(prepaid and insured). To ship the unit, pack the carrying
case in the original carton or equivalent, with plenty of
padding.

This Limited Warranty does not apply to product damage
resulting from accident, incorrect installation, unauthorized
modification, misuse or abuse.

U.S.A. and Canada Before you return your equipment for repair, please call
Polaroid Electronic Imaging Technical Support from within
the U.S.A. at 1-800-432-5355, Monday through Friday, 8 a.m.
to 8 p.m., Eastern Time. In Canada, call 1-800-268-6970. 
We can help you determine what is at fault, and advise you
on how and where to get service in the quickest and most
convenient way.

THIS WARRANTY EXCLUDES ALL INCIDENTAL AND 
CONSEQUENTIAL DAMAGES. ALL EXPRESSED OR
IMPLIED LIABILITY FOR THIS EQUIPMENT INCLUDING 
BUT NOT LIMITED TO THE IMPLIED WARRANTY OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE LIMITED IN DURATION TO THE ONE-YEAR
WARRANTY PERIOD.

Troubleshooting 115
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SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES OR THE DURATION OF IMPLIED WARRANTIES
SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.
THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS,
AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH MAY
VARY FROM STATE TO STATE.

Outside the U.S.A. THIS WARRANTY EXCLUDES ALL INCIDENTAL AND 
and Canada CONSEQUENTIAL DAMAGES AND DOES NOT AFFECT

YOUR STATUTORY RIGHTS.

Note: No user-serviceable parts inside, with the exceptions
of the lamp and air filters which can be replaced as
described in this manual. Attempts to modify mechanical or
electronic parts inside will void your warranty, and may be
hazardous.
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Color 16.7 million colors

Display technology LCD: active matrix 1024 x 768

Resolution Multiple graphics modes (640 x 480, 800 x 600, 
1024 x 768, 1152 x 900, 1280 x 1024, 72 Hz)

Contrast ratio 100:1 typical

Video compatibility NTSC M 3.58 MHz; PAL B, G, H, I 4.42 MHz; SECAM 4.43
MHz; S-VIDEO

Projection lamp 575 watt metal halide

Brightness 300 ANSI lumens (typical)

Keystone correction 4.5 degrees

Audio system Digital stereo sound, two built-in 3 watt speakers

Inputs 1 computer video
2 composite video (NTSC, PAL, SECAM)
2 S-video
1 computer stereo audio
2 composite video stereo audio
1 microphone
Cyclops interactive pointer system

Appendix A: Specifications
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Outputs Stereo audio (2 RCAs)
1 computer audio
1 monitor

Power source 90-265 VAC, 50-60 Hertz

Dimensions Closed -13.8 in. (H) x19.8 in. (W) x 7.3 in. (D) 
(35 x 50.2 x 18.5 cm)
Open - 13.8 in. (H) x 19.8 in. (W) x 25.1 in. (D)
(35 x 50.2 x 63.75 cm)

Weight 31.6 lbs. (14.3 kg)

Projection distance 4 ft. to 12 ft. (1.22 m to 3.7 m)

Compatibility IBM PC, PS/2 and compatibles
Apple: Macintosh II, LC, Quadra, Centris, Performa, and
PowerBook. Apple Macintosh Classic, Classic II, compact
Macintosh family.
Workstations: Sun, Hewlett-Packard, IBM RS/6000, Sili-
con Graphics, DEC Alpha, Intergraph, NeXT.

118 Appendix A



Dow
nlo

ad
ed

 fr
om

 P
ro

jec
to

r.c
om

Replacement product Part No.

Remote control 622190

Power cord, IEC, North America C1002-10

Power cord, IEC, Europe C1001-10

Power cord, IEC, Italy C1003-10

Power cord, IEC, UK C1004-10

VGA-to-LCD cable C800-6

Mac-to-LCD adapter C804-0

Mac-to-LCD cable C802-6

Mac ADB cable C470-6

13C3-to-LCD cable C801-6

SGI-to-LCD adapter C947-12

SGI 13C3-to-LCD cable C943-6

DEC 3C3-to-LCD adapter C947-10

DEC 3C3-to-LCD cable C948-6

DEC 3C3 cable/adapter (A38) kit 623402

S-video cable C466-6

Computer audio cable C498-6

Serial cable C936-6

Composite audio/video cable C497-6

Mini-jack to RCA cable adapter C5105

BNC cable (A37) kit 622188

Appendix B: Parts
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Replacement product Part No.

Polaroid F/X diskettes (Windows version 3.x) 080-00866-1

Polaroid F/X diskettes (Windows 95) 080-00867

Lamp assembly 623403

Adobe Acrobat Player System 621822

Cyclops interactive pointer system 622189

Laser pointer 623404

Loudspeaker system A55

Polaview projector hard case 612306

You can order accessories and replacement parts
through your local dealer or by contacting Polaroid (see
pages 113 and 114).
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What are sense lines? This appendix explains how to adjust the projector if you
have trouble connecting to a computer with no external
monitor.

Certain display cards and video systems rely on sense-line
information from the monitor to configure themselves cor-
rectly for display resolution. The absence of sense-line infor-
mation causes some display cards to output a default video
signal, and actually prevents some video cards from out-
putting video at all.

Sense-line information is only required when you are using
a system without a monitor and the video card defaults to
an incompatible resolution. Sense-line information can be
found in the technical documentation that came with your
computer.

Configuring the 1 Determine the default resolution for your video system.
Polaview Model 305 2 Gather sense-line information from your computer doc-

umentation or from your video card documentation. Typical
sense-line settings are listed later in this appendix.

3 Connect and turn on the projector.

4 Choose the Advanced menu. 

5 Set Sense 3, Sense 2, Sense 1 and Sense 0 to the settings
recommended for your system. 

Appendix C: Sense lines
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6 Exit the menus and restart your computer (do not turn off the
projector).

Macintosh displays The next table shows typical sense-line settings for Macintosh
systems, based on the system resolution. Try these settings
only if you have trouble projecting an image without an exter-
nal monitor connected to the computer.

Remember to restart your computer after you make these
changes.

Display resolution Sense-line setting(s)

640 x 480 Sense 3: High
Sense 2: High
Sense 1: High
Sense 0: Low

1152 x 870 Sense 3: High
Sense 2: Low
Sense 1: Low
Sense 0: Low

832 x 624 and Your system needs a Macintosh termina-
1024 x 768 tor. Try the Macintosh Sync Adapter 

(02-20-UNV) available from Griffen Com-
munications Corp., 1451 Elm Hill Pike,
Park Elm Bldg, Suite 100, Nashville TN
37210 (615) 399-0990 fax: (615) 399-7060.

Identifying To determine the current sense-line setting:
sense-line settings

1 Connect the projector to the computer and the monitor.

2 Make sure all hardware is turned on and that the correct resolu-
tion is displayed on the monitor and through the projector.

3 Open the projector menus and choose Input Source, 
Input Measurements. The four sense-line settings appear in the
window.
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Input Measurements
windows

Sense line settings for popular video cards

Graphic card/ 
System Monitor type Resolution Sense 3 Sense 2 Sense 1 Sense 0

Hewlett- OmniBook 640 x 480 High High High Low
Packard

MAC / RGB 13" 640 x 480 High High High Low
PowerBook1

16" 832 x 624 High High High High
(with terminator2)

RGB 19" 1024 x 768 High High High High
(with terminator2)

RGB 21" 1152 x 870 High Low Low Low

Sun GX 1152 x 900   66 Hz High Low High High
SPARC
station

1152 x 900   76 Hz High High Low Low

1280 x 1024 76 Hz High Low High Low

GXplus 1152 x 900   66 Hz High High High High

1152 x 900   76 Hz High High High Low

1280 x 1024 67 Hz High High Low Low

1 Per Apple, the PowerBook only displays resolutions up to 832 x 624.

2 The Griffin Mac Sync Adapter can select many different resolutions through switch settings on the adapter itself.
Instructions to use these switches are included with the adapter. To contact Griffin regarding the adapter (part number
02-20-UNV): Griffin Communications Corporation, 1451 Elm Hill Pike, Suite 100, Nashville, TN 37210, phone (615) 399-
0990, fax (615) 399-7060.
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Graphic card/
System Monitor type Resolution Sense 3 Sense 2 Sense 1 Sense 0

Sun TurboGX/ 1024 x 768   60 Hz High High Low High
SPARC TurboGXplus
station

1152 x 900   66 Hz High High High High

1152 x 900   76 Hz High High High Low

1280 x 1024 67 Hz High Low High Low

1280 x 1024 76 Hz High Low High High

ZX 1024 x 768   76 Hz High Low Low Low

1152 x 900   66 Hz High Low High High

1152 x 900   76 Hz High High High Low

1280 x 1024 76 Hz High Low High Low

Sun SPARC Voyager 1024 x 768   76 Hz High Low Low Low

1152 x 900   76 Hz High High High Low

Silicon Multiscan 1280 x 1024 76 Hz Low Low Low High
Graphics3 (Indigo2 with 

XL graphics 
and Indy)

Multiscan 1280 x 1024 76 Hz High Low Low High

Single Scan 1280 x 1024 76 Hz High Low High Low

Single Scan 1024 x 768   76 Hz High High High Low

RDI PowerLite 1152 x 900   76 Hz Low High Low Low

3 Using sense lines with Silicon Graphics workstations requires the use of the Polaview C943-6 SGI 13C3 cable. 
This cable is available in the Polaview SGI Cable Accessory Kit (part no. A36).
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A

Adapters, 24
Adjusting the contrast, 101
Adjusting the brightness, 101
Adjusting the volume

Volume keys, 53
Adobe Acrobat Player 

System, 2, 32
connecting, 32
PDF files, 2

Adobe Acrobat Player System
key, 13, 46–47

Advanced features, 59
Advanced menu, 62, 70

Hor. Pos, 70
Sense 3, 2, 1, 0, 70
User, 70
VCO gain, 70
Vert. Pos, 70

Air flow, 38
Arm release lever, 17–18
Arrow keys, 14, 47
AUDIO 1/2 IN, 22
Audio adjustments, 53

balance, 53
bass control, 53
displaying the 

volume slider, 53
fade, 53
treble control, 53

Audio menu, 62, 67
Audio mode, 67
Balance, 67
Bass, 67
Fade, 67
Mic. Volume, 67
Mute, 67
Treble, 67
Volume, 67

AUDIO OUT, 23

B

Balance, 53
Bass and treble controls, 53
BNC block-to-LCD connector

cable, 31
BNC connections, 30–31
BNC-to-LCD connector

cable, 31
Break timer, 58
Brightness

adjusting, 101
Brightness

setting, 51

Index
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C

Cables
included, 24
optional, 24

Cleaning/changing 
air filters, 91–96

right filters, 93–96
top filter, 93–94

CLEAR key, 14, 48
Closing the projector, 19
Compatibility list, 108–111
Composite audio/video 

cable, 34
COMPUTER AUDIO IN, 22
COMPUTER IN, 23
COMPUTER OUT, 23
Connecting a microphone, 35
Connecting a monitor, 22–23
Connecting an external 

stereo system, 38
Connecting external 

speakers, 36
Connecting video and 

audio, 33–37
computers, 35
S-video sources, 34
VCRs, 33

Connecting without 
a monitor, 25

Connecting your computer
13C3 connections, 28
BNC, 30
DEC 3C3, 30
Macintosh, 26
Notebook computers, 27
PCs, 25

Connector panel, 22–23
AUDIO 1/2 IN, 22
AUDIO OUT, 23
COMPUTER AUDIO IN, 22
COMPUTER IN, 23
COMPUTER OUT, 23
CYCLOPS port, 23
MIC, 23
S-VIDEO 1/2, 22
VGA OUT, 23
VIDEO 1/2, 22

Contrast
adjusting, 101

Contrast
setting, 51

Control panel, 12–14, 46–48
Correcting shimmering 

or streaks, 51–52
Adjusting the Sync, 51–52

Correcting vertical banding, 52
Adjusting the Dot Clock, 52
Adjusting the Red, Green, 

and Blue settings, 52
Adjusting the Tint, 52

Cyclops interactive 
pointer system, 2, 76

connecting, 32
Cyclops menu, 63

Button, 63
Calibrate, 63

CYCLOPS port, 23
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D

DEC 3C3-to-LCD adapter, 30
DEC 3C3 video 

connections, 30
DEC 3C3-to-LCD connector 

cable, 30
Diagonal image size, 43
Distance from screen, 43
Dot Clock adjustment, 101
Draw mode, 13, 47, 55, 62
Draw tool, 13, 47, 55–58, 61, 62, 

69, 74
Draw toolbar, 56–58

E

External speaker system, 36
External stereo system, 37

F

Fade, 53
Fade and balance, 53
Filters, 91–96
Flip mirror, 6–7, 18, 19

cleaning, 87
release lever, 6, 18

Focus, 41
Forward key, 13, 46

H

H-Sync values, 100
Half-normal height, 103
Hor. Pos

adjusting, 101
Horizontal double image, 102

I

Image adjustments, 41–43, 51–52
brightness, 51
contrast, 51
correcting keystoning, 42
focusing the image, 41
image size, 43
raising or lowering 

the image, 41
Image menu, 65, 66

Blue, 65
Bright, 65, 66
Contrast, 65, 66
DotClk., 65
Factory Default, 65
Green, 65
Interlace, 65
Red, 65
Saturation, 66
Sync, 65
Tint, 66

Image position, 52
Image size, 43
Input Measurements 

window, 100
Input Source menu, 64

Input Measurements, 64
Source mode, 64
Source Select, 64

Input sources
definition, 49
SOURCE key, 46
switching, 46
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K

Keystoning, 42

L

Lamp
replacing, 89–91
installing the new 

lamp, 90–91
lamp type, 121
removing the old lamp, 89–90

Lamp indicator, 48
Lamp on/off key, 12, 39, 47
Lighting the lamp, 11

M

Mac-to-LCD adapter, 27
MAC-to-LCD connector 

cable, 26
Macintosh connections, 26
Main menu, 61–62

Advanced, 62
Audio, 61
Cyclops, 61
Image, 61
Input Source, 61
Preferences, 62
Projector, 61
Tools, 61

Maintenance, 87–96
cleaning the air filters, 91–96
cleaning the lens 

and mirror, 87
cleaning the projection 

window, 88
replacing the lamp, 89–91

MENU key, 13, 47
Menus, 61–70

Advanced, 70
Audio, 67
changing the language, 50
Cyclops, 63
Image, 65, 66
Input Source, 64
Main, 61–62
Preferences, 69
Projector, 68
reverting to 

factory defaults, 51
saving your settings, 50
Tools, 62
using, 50–51

MIC, 23
monitor connection, 22–23
MouseDisk, 13, 47
Moving the projector, 20

while open, 20
Mute, 12, 47, 53
MUTE key, 12, 47

N

Notebook-computer
connections, 27–28
setting the projector as 

an external monitor, 28

O

Opening the projector, 16
Over-temp 

indicator, 14, 40, 48
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P

Parts
replacement, 118–119

Pause key, 13, 46
PC connections, 25
PDF file, 32
Polaroid F/X, 13, 46, 71–86

Assignments area, 74
customizing effects, 75
Cyclops interactive pointer 

system, 76
Freeze, 79
installing, 72
Menu commands, 83–84
Presentation effects, 80–86
See It/Show It, 78
special effects, 73
starting an effect, 80
starting, 73

Polaview cables
included, 24
optional, 24

Positioning the projector, 16
Power consumption, 21
Power switch, 21
Precautions, 38–40
Preferences menu, 69

Colors, 69
Language, 69
On-screen, 69
Prog Key 1, 69
Prog Key 2, 69

PROG 1, 2 keys, 12, 13, 46
Projecting transparencies, 58
Projecting with a 

separate monitor, 24
Projection lens

cleaning, 87
Projector menu, 68

Lamp Hours, 68
Projection, 68

Q

Quick Start, 5
connecting video 

and audio, 10
connecting your 

computer, 7–10
setting up the projector, 6–7
turning on the projector, 11

R

Rear projection, 52
Recessed carrying handle, 20
Remote control, 12–14, 46–48

batteries, 4, 96
LAMP key, 12, 47
MENU key, 13, 47
MouseDisk, 13, 47
MUTE key, 12, 47
PROG 1, 2 keys, 12, 46
programming, 57
Reverse/Forward/Pause 

key, 13, 46
SETUP key, 13, 46
SOURCE key, 12, 46
VOLUME keys, 12

Remote-control 
mouse tracking, 54

Replace lamp indicator, 14, 48
Replacement parts, 119–120
Reverse key, 13, 46
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S

S-VIDEO-1/2, 22
SCALE feature, 59
SCALE key, 13, 47
See-It/Show It, 13, 46, 78
Sense lines, 25

definition, 121
Macintosh displays, 122

Setting up the projector, 6–7
SETUP key, 13, 46
Silicon Graphics, see SGI
SGI 13C3-to-LCD connector

cable, 29
SGI connections, 29

without an external 
monitor, 29

SGI-to-LCD adapter, 29
SOURCE key, 12, 46
Source mode

selecting, 100
Specifications, 117–118
Sync adjustment, 101
Sync setting, 51

T

Technical support, 112–114
Temperature 

extremes, 96
13C3 connections

SGI, 29
standard, 28

13C3 to LCD Connector 
Cable, 28

Tools menu, 62
Break Timer, 62
Break Timer Value, 62
Draw, 62
Draw mode, 62
Mouse Tracking, 62

Troubleshooting, 97–116
Turning on the projector, 21
Turning the lamp off, 39–40

U

User profiles, 60

V

V-Sync values, 100
VCO Gain

adjusting, 102
Vert. Pos

adjusting, 102
Vertical double image, 104
VGA OUT, 23
VGA-to-LCD connector 

cable, 25
VGA/MAC adapter, 26
VIDEO 1/2, 22
Volume, 53

Mute key, 12, 47, 53
VOLUME keys, 12, 46

W

What’s in the box, 3–4
Workstations, 28–31
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“Polaroid” and “Polaview” are trademarks of Polaroid Corporation, Cambridge, MA, U.S.A. “Cyclops” is a registered
trademark of Proxima Corporation. “IBM” is a trademark of International Business Machines Corporation. “Macintosh”
is a trademark of Apple Computer, Inc. “Adobe”, “Acrobat“, and “Acrobat Player” are trademarks of Adobe Systems
Incorporated. Other trademarks may be the property of their respective owners. U.S. patent number 5,510,861 applies
to the Polaview Model 305. Other U.S. and foreign patents are pending.
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